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1 イントロダクション 

Tecplot 360 EX を使用するとインタラクティブな検索、可視化、CFD データの分析によって結果を明確に示すこと

ができます。Tecplot 360 EX によって高品質なプロットを作成し、レポート、論文、プレゼンテーション、ビデ

オ、Web サイトに適用することが可能です。 

Tecplot 360 EX のユーザー向けに、以下の参考資料が用意されています。 

• Getting Started Manual （このドキュメント） - 実際に使用するデータに類似した内容のデータファイ

ルを使用して主要な機能の操作方法を中心に説明します。 

• User’s Manual - すべてのの機能の説明が網羅されています。 

• Scripting Guide -  Tecplot 360 EX マクロの操作およびシンタックスに関する詳細な情報が提供されて

います。 

• Quick Reference Guide - プレースホルダー、キーボードショートカット他 、微細な操作を参照できる

便利な資料です。  

• Data Format Guide - Tecplot のデータフォーマットおよびその記述方法が説明されています。 

• Installation Guide - Tecplot 360 EX のインストール方法について説明しています。  

• Release Notes - プラットフォームの詳細情報とともに、 Tecplot 360 EX の最新情報が提供されていま

す。 

このマニュアルには Tecplot 360 EX を初めて使用するユーザー向けに、4 つのチュートリアルが用意されていま

す。 

このドキュメントに記載されたトピックについての詳細は Tecplot 360 EX のインストールディレクトリに格納され

ている User’s Manual を参照するか弊社の Web サイトを参照してください:https://www.tecplot.com/ 

documentation/.

https://www.tecplot.com/documentation/
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1 - 1   このチュートリアルを始める前に 

このチュートリアルを始める前に User’s Manual の第 1 章 および 2 章をざっと読んで Tecplot 360 EX のユーザー

インターフェースを確認し操作の基本概念に慣れておくことをお勧めします。各章を読む際は、 Tecplot 360 EX を

開いておき、実際に操作できるようにしておくと便利です。 

• 第 1 章 - イントロダクション Tecplot 360 EX の初期画面、サポートされている入力装置、ワークスペ

ース、メニューバーおよびグローバルツールバー、コンテキストメニューおよびツールバー、そしてサ

イドバーについて取り上げます。このチュートリアルの内容を理解しやすくするために Tecplot 360 EX 

の主要なユーザーインターフェースに慣れることをめざします。 

• 第 2 章 - ワークスペースを使用するデータ階層、座標系、フレーム、ワークスペースの管理、表示の調

整、編集メニューについて取り上げます。続いてこれらの多くの概念を念頭に置きながら実践していき

ます。このチュートリアルが終了したら、再び 第 2 章に戻って参照してみるとよいでしょう。 

1 - 2   このガイドにおけるチュートリアル 

この 『Getting Started』 マニュアルは、チュートリアルで分かれており、身近なトピックの多様な側面をカバー

する一連のエクササイズが用意されています。チュートリアルは好きな順番で参照できるように作成されています

が、可能な限り記載の順番で進めることをお勧めします。 

以下のチュートリアルが用意されています。 

• 外部流れのチュートリアル - Onera M6 wing モデルを使用して、データのロード、基本的なプロット、

スライス、流線、等値面、プロービング、およびシミュレートしたデータと実験データの比較 (データの

正規化を含む) について取り上げます。 

• ボリュームサーフェスについて - Tecplot 360 EX で、 Surfaces to Plot を使用してボリュームサーフ

ェスにレンダリングする方法を DuctFlow データセットを例に用いて説明します。 

• 過渡データ - 127 時間ステップの風力タービンデータセットを使用して過渡 (時間ベース) データの構

築、等高線プロットのアニメーション、解析用の時系列データの抽出、および Tecplot 360 EX の解析ツ

ールを用いた追加変数の計算と可視化について学びます。 

• 有限要素解析 - LS-DYNA で作成された回転ロッドの過渡 FEA データセットを使用して、最大ミーゼス

応力を可視化する複数の方法を検討します。 

このガイドのすべてのチュートリアルにはデータセットが用意されており、Getting Started Bundle に格納されて

います。Getting Started Bundle だけでなく、インストールディレクトリの example フォルダにも、若干のデー

タセット、OneraM6Wing および DuctFlow.plt が格納されています。  

掘り下げて考察し、表示をマスターしてください。  

https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
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2 外部流れのチュートリアル 

Onera M6 wing はレイノルズ数が大きい場合の低速から遷音速における 3 次元流体の基礎研究に利用されました

（局所超音速流、衝撃、乱流境界層の剥離など）。この翼は風洞において 4 つの異なるマッハ数とさまざまな迎角を

用いて NASA（アメリカ航空宇宙局）によって試験されました。これには単純形状、複雑な流れが存在し、さらに

CFD ソリューションの妥当性を検討することができる実験データも含むため現在では外部流れの CFD 検証の典型的

なケースとなっています。1 

このチュートリアルでは Tecplot 360 EX の入門として Onera M6 のデータセットそ使用し、まずは基礎的な操作

（データのロードと表示）を紹介します。それから中級および上級の内容に進みます。このデータセットを採用した

のは既に慣れているユーザーが多く、また初心者でも理解しやすい内容だからです。 

Onera M6 データセットは OneraM6wing フォルダの中の Getting Started Bundle に格納されています。 

このチュートリアルは 3 つに分けられています。各セグメントの終わりにはレイアウトファイルが用意されており

作業を確認することができます。3 番目のセグメントでは機能拡張されたプロットを作成するためのマクロとその結

果を表示するレイアウトも含まれています。各セグメントの詳細を以下に示します。 

番号とレベル タイトルと説明 

1 - 初級 

データのロードと操作 - Onera M6 のシミュレーションデータセットを Tecplot 360 

EX にロードして等高線プロットを作成します。3 次元プロットの回転、表示、カラー

メッシュの方法を検討します。また、等高線グループとカラーマップを設定し凡例を

表示します。 

                                 
1 . Onera M6 wing の詳細については https://turbmodels.larc.nasa.gov/onerawingnumerics_val.html を参照ください。 

https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
https://turbmodels.larc.nasa.gov/onerawingnumerics_val.html
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2 - 中級 

CFD ソリューションについて - スライス、流線、等値面 （iso-surface）を追加し、

データを検証することで Onera M6 シミュレーションデータセットの理解を深めま

す。 

3 - 中級 

CFD シミュレーションデータと実験データの比較 - シミュレーションしたデータと実

験データを比較して圧力の係数 (Cp) プロットを作成します。シミュレーションデー

タセットの次元の正規化も行います。 

以下の web サイトからこのチュートリアルビデオが視聴できます。 

https://www.tecplot.com/category/tecplot360-videos/external-flow/ 

このビデオの内容は印刷されたチュートリアルと少し異なる場合がありますが、同じ内容をカバーしています。

https://www.tecplot.com/category/tecplot-360-videos/external-flow/
https://www.tecplot.com/category/tecplot-360-videos/external-flow/
https://www.tecplot.com/category/tecplot360-videos/external-flow/
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2 - 1   データのロードと操作 

Step 1  Tecplot 360 EX を起動しデータセットをロードする 

Windows の場合は Start メニューをクリック、Linux の場合はターミナルウィンドウに tec360 、Mac OSX の場合

はアプリケーションフォルダ内で目的のアプリケーションアイコンをクリックして Tecplot 360 EX を起動します。

Tecplot 360 EX の初期画面が以下のように表示されます（このドキュメントでは Windows バージョン Tecplot 

360 EX の例を示しますが他のプラットフォームでもほぼ同様に表示されます）。 

 

初期画面は  Tecplot 360 EX を起動するたびに表示され、最近使用したレイアウトに簡単にアクセスすることがで

きます。また、ドキュメンテーションおよび有用な他の資料に素早くアクセスできるリンクも表示されます。 

Onera M6 データのロードを開始するには初期画面の上部から Load Data をクリックします（または、メニューバ

ーの File ドロップダウンメニューから Load Data を選択するか、ツールバーの左から 2 番目にあるフォルダアイ

コンをクリックします。初期画面が表示されないときに便利です）。  

Load Data ダイアログが表示されます。 
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Tecplot 360 EX のインストールフォルダから examples > OneraM6wing フォルダに移動します。次に 

OneraM6_SU2_RANS.plt ファイルをダブルクリックして Tecplot 360 EX 内でファイルを開きます(このファイ

ルが表示されない場合はダイアログの下部にあるメニューから All Files を選択してください)。データファイルが開

かれ、以下のように Tecplot 360 EX ワークスペースに Onera M6 wing が表示されます。 
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Step 2  翼を回転させる 

翼の表示を回転させるには Control キー（Mac の場合は Command キー）を押しながら Tecplot 360 EX のワーク

スペース内でマウスを右クリックして動かします。 

回転範囲が十分ではなく大きな変更を加えて翼を表示しにくいことに気づくでしょう。これは、回転の原点（回転が

実行される周囲のポイント）が翼付近のどこにも設定されていないためです。これを変更するには画面上の翼のおよ

そ中心の位置にマウスのポインターを置き、キーボードで小文字の O（origin の意味）を押します。 

それから、Control キー（Mac の場合は Command キー）を押したまま再度マウスを右クリックしてドラッグしま

す。中央の周りを回転するするようになり、翼を回転しやすくなったことがわかるでしょう。 

Step 3  データセットに関する情報の表示 

Onera M6 データセットの情報を確認するには Data のドロップダウンメニューから 

Data Set Info を選択します（左図参照）。以下のように Data Set Information ダイア

ログが表示されます。 

このダイアログではデータセットに関する情報が豊富に提供されています。ゾーンとデータセット内の変数の名前が

ダイアログの上部にある 2 つのリストに示されます。 

このデータセット内のゾーンを以下に示します。 

• FluidVolume - 翼周辺の空気 

• WingSurface - 翼自体のサーフェス 



 2 - 1   データのロードと操作 
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Information ダイアログの 3 つのタブ内の内容も確認できます。Help ボタンをクリックすると任意のダイアログの

ページで表示された情報の詳細を確認することができます。終了したら Data Set Information ダイアログを閉じて

ください。 

Step 4  流体ボリュームゾーンの境界ボックスを無効にする 

ステップ 2 で、翼を回転させるとプロット内でオレンジ色の破線が走ることに気づいているかも知れません。ここ

でそれが垣間見られました。 

 

これは流体ボリュームゾーン（FluidVolume zone）の境界ボックスで翼の周囲の空気を表します。このゾーンには

スタイル（外観）が存在しないため通常は表示されません。Tecplot 360 EX この存在と大きさがわかるようにオレ

ンジ色の破線が追加されます。 
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メニューバーから View > Fit Everything を選択して、すべてのボ

リュームゾーンを確認します (右図参照)。翼はデータセットのほ

んの一部分です。View>Last を選択して前の表示に戻ります。 

境界ボックスによって作成中のプロットに何か追加することはない

のでこれはオフにします。Options メニューから Show Bounding  

Boxes for Enabled Volume Zones with No Style を選択しま

す。オレンジ色のラインが非表示になります。 

 

 

 

Step 5  コンテキストツールバーを使用してメッシュを表示する 

翼面のゾーンのメッシュを表示するには、 Tecplot 360 EX ワークスペースに表示されている翼の上で右クリックし

ます。コンテキストツールバーが以下のように表示されます。 

 

このツールバーには左から右へとメッシュ、等高線、ベクトル、陰影、エッジ、透過性を表示するボタンが配置さ

れ、オン/オフを切り替えることができます。一番始めのボタンをクリックして WingSurface のゾーンのメッシュ

を表示します（以下参照）。 
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Step 6  メッシュの色を変更する 

Plot サイドバーの上部にはプロットのレイヤーを オン/オフ にできるメニュー

が用意されています。このツールバーに表示されている Zone Style ボタンをク

リックすると、以下のような Zone Style ダイアログが表示されます。 

Mesh Color 列（緑色の列の一番右）では、WingSurface を含む各ゾーンのメ

ッシュの色が表示されます。Color Chooser ダイアログに表示された色見本で

黒を右クリックします。 
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Color Chooser では、無地一色を選択したり、ダイアログの下部にある 1-8 のボタンを使用していくつかの変数値

に基づいたグラデーションなど、等高線を使用して色付けられたメッシュカラーを選択したりすることができます

（実際にはこれらの番号は変数とカラーマップを関連付ける Tecplot 360 EX8 つの等高線グループを参照します。

等高線については後ほどさらに詳しく検討します）。  

ここではメッシュに青色を選択しましょう。 

 

Zone Style ダイアログを閉じると、再び wing surface が見えます。 

補足: コンテキストメニューおよびツールバー 

翼を右クリックしてみてください。コンテキストメニューとツールバーが表

示されダイアログを表示せずに Zone Style ダイアログと同様の変更を行う

ことができます。ここでは、（ツールバーの最初にある）メッシュアイコンの

右のドロップダウンメニューを使用してメッシュの色を変更しています。多

くのゾーンのスタイルを一度に変更する場合は、Zone Style ダイアログを使

用することをお勧めします。その他多くの場合はコンテキストメニューとツ

ールバーを使用するほうが素早く目的の項目にアクセスできます。 

以降のステップでは、このコンテキストメニューを使用します。 
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Step 7  等高線グループとカラーマップを設定する 

Onera M6 データには数多くの変数が用意されています。この可視化に興味を持

つユーザーもいるでしょう。翼のサーフェス上で等高線としてこれらを表示でき

るようにカラーマップを設定してみましょう。まず、Plot サイドバーで Contour 

layer を有効にします。それから、Contour チェックボックスの隣にある 

 ボタンをクリックして Contour & Multi-Coloring Details ダイアログボック

スを開きます（以下参照）。 

ダイアログ上部には変数を選択するためのドロップダウンメニューが用意されています。この隣にある 8 つの番号

で構成されたボタンではユーザーが編集している 等高線グループ を指定します。それぞれの等高線グループにはこ

のダイアログ用の独自の設定があります。等高線グループによってカラーマップとその他の設定を伴う変数を関連付

けることができます。カラーマップに特定の変数の値に準拠してゾーンを何色にするかを指定します。 

このチュートリアルでは 2 つの等高線グループを設定します。最初に Large Rainbow カラーマップで密度が表示さ

れます。2 番目には Magma カラーマップを使用して圧力係数が表示されます。 

まず、プロットとダイアログをほぼ一緒に表示できるようにダイアログを移動します。 

1.Contour & Multi-Coloring Details ダイアログの上部にある等高線グループが 1 に設定されているか確

認してください。 

2.ダイアログ上部のドロップダウンメニューでは変数、Density を選択しているか確認してください。 
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3.Color map preview のドロップダウンメニューから Large Rainbow を選択します。 

4.Color Map Distribution Method は Continuous を選択します。 

上記のようなダイアログが表示されます。既にデフォルトで等高線グループに 1 が使用されているため、ダイアロ

グのメニューを変更するたびにプロットが変化することに気づくはずです。 

次に圧力係数に等高線グループ 2 を設定します。 

1.Contour & Multi-Coloring Details ダイアログ上部で 2 をクリックし等高線グループ 2 を選択します。 

2.ダイアログ上部にあるドロップダウンメニューから変数、Pressure_Coefficient を選択します。 

3.Color map preview のドロップダウンメニューから Magma を選択します。 

4.Color Map Distribution Method は Continuous を選択します。 

5.カラーマップのレベルも変更する必要があります。Set Levels ボタンをクリックして Enter Contour 

Levels ダイアログを表示し、Minimum level を -1 に、Number of levels を 21 に変更します（以下

参照）。 

 

6.OK をクリックして、Enter Contour Levels ダイアログを選択します。 

以下のように Contour & Multi-Coloring Details ダイアログが表示されます。 
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Step 8  プロットの等高線 Group を変更 

等高線グループを設定したので Contour & Multi-Coloring Details 

ダイアログを閉じます。プロットサイドバーで等高線レイヤーがチェ

ックされていることを確認します。 

翼を右クリックしてコンテキストメニューを表示し contour アイコ

ンの隣にあるドロップダウンメニューをクリックし、Contour group 

2 を選択すると翼に表示された等高線変数を変更することができま

す。(C2:  圧力係数） 

ここまでの操作で、プロットは以下のように表示されます。 
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Step 9  凡例の書式を設定する 

等高線の凡例は便利ですがプロットに重なっています。凡例のタイトルをダブルクリックして Contour & Multi-

Coloring Details ダイアログの Legend ページを開きます（以下参照）。 
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これは直近で閉じたダイアログと同じで単に表示されているページが異なるだけです。Plot サイドバーで Contour 

の隣にある  ボタンをクリックするか、 Tecplot 360 EX メニューバーから Plot>Contour/Multi-Coloring を選

択しても同じ画面を表示することができます。 

Contour & Multi-Coloring Details ダイアログでは以下の操作を行います。 

1.アライメントを水平（horizontal）に変更する。 

2.Automatic resizing をオンにする。 

目的の設定は上図のとおりです。これらの設定を変更したらダイアログを閉じてください。 

マウスを使用して凡例をプロットの下部まで移動することもできるようになりました。最終的にプロットは以下のよ

うに表示されます。 
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このセグメントの操作で最終的に示された結果のスナップショットを含む Tecplot 360 EX レイアウト (.lay) ファ

イルは Tecplot 360 EX インストールフォルダ> examples フォルダ  

OneraM6wing/finallayouts/ExtenalFlowVideo1.lay  に格納されています。この内容と自分の結果を比較して

確認することができます。 

自分が作成したレイアウトの保存も可能です。その場合、 Tecplot 360 EX メニューバーから File>Save Layout を

選択し、レイアウトを保存するフォルダを指定して名前を付けたら Save をクリックします。 
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2 - 2   CFD ソリューションについて 

このセグメントでは、スライス、流線、等値面（iso-surface） について取り上げます。これらのツールはソリュー

ションにおけるボリュームデータをより近くで見るために頻繁に使用します。 

翼のサーフェスに圧力係数が表示されている状態で前のセグメントの終わりでそのままになっている箇所から開始し

ます。前のセグメントを学習後 Tecplot 360 EX を閉じてしまった場合は Tecplot 360 EX のインストールフォルダ

にある examples フォルダから、レイアウトファイル OneraM6wing/finallayouts/ExtenalFlowVideo1.lay  を

ロードすると該当箇所から続けることができます。 

Step 1  スライスの追加 

スライスを追加するには Plot サイドバーにある Slices チェックボックスをオンにし

ます。ボリュームゾーンを通してスライスが表示されます。  

 
このチュートリアルの最初のセグメントで決定したようにボリュームゾーンは翼より

もはるかに大きいものです。そのため、そのゾーンを通ったスライスはプロットの大

部分を占めます。突然、画面がほとんど無地の色で塗りつぶされるのはこうした理由

からです（このチュートリアルでは黄色ですが、緑色やその他の色の場合もありま

す）。 

このスライスは等高線グループ 1 を使用しているため、Density の凡例が表示されます。 
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マウスでスライスを移動するにはまず、Plot サイドバーで Slice ツールを

クリックし、次に Slices チェックボックスをオンにします。  

翼の表面をクリックします。（スライスが前面にあるため、恐らく最初は

翼は表示されないかもしれません。しかし見えていなくても翼をクリックすることはできます）。ユーザーがクリッ

クしたポイントを通すためにスライスが移動します。さまざまな位置でのスライスを以下に示します。 

 

翼の表面でマウスをドラッグ してスライスの場所を微調整することもできます。青灰色の翼のプレビューはユーザ

ーがマウスのボタンを離したとき、どこにスライスが存在するかを表示します。 
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Step 2  Slice Details の設定 

Slice Details ダイアログを起動するには Plot サイドバーの Slices の隣にある  ボタンをクリックします。 

 

Slice Details ダイアログについて少し確認します。 
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• Contour Details ダイアログと同様、上部に 8

つのボタンがあります。これは偶然ではありま

せん。Tecplot 360 EX では、8 つの等高線グ

ループと同様に、8 つのスライスのグループが

サポートされています。各スライスグループ

で、同じ法線およびスタイルが使用されますが

位置はそれぞれ別にすることができます。その

他、さまざまな設定もそれぞれのスライスグル

ープで個別に指定することができます。  

これらの番号ボタン Tecplot 360 EX によっ

て、編集したいスライスのグループを指定しま

す。 

• スライスの方向を特定の平面に向けて手動で変

更することができます。現在、スライスは X 平

面に設定されています（デフォルト）。翼の後

流が表示されるため、ここでは AY 平面のスラ

イスに設定するほうが便利です。変更してみま

しょう。  

ダイアログで任意の方向を選択することもできますが、このチュートリアルではこの機能は使用しませ

ん。 

• 始めと終わりのスライス、およびいくつか中間のスライスを指定することで、複数のスライスを設定で

きることがわかります。スライスするデータの種類を選択することもできます。 

Slice Details ダイアログを開いたまま、さまざまな場所にスライスを移動することができます。プロット内でスラ

イスを移動するたびにダイアログのスライス位置のフィールドが更新されることに注意してください (Tecplot 360 

EX のほとんどのダイアログは操作中に開いておくことが可能で他の手法で更新すると常に更新されます)。 
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Step 3  等高線の表示 

Slice Details ダイアログを開いたので、このダイアログの 

Contour ページを概観してみましょう。このダイアログでは

スライスの色付けを指定することが可能です。  

これは前のセグメントで説明した等高線グループと関連しま

す（ 等高線グループとカラーマップを設定する を参照して

ください）。等高線グループはカラーマップを変数に結び付

けます。そのためプロット内のオブジェクトは選択した変数

の値に基づいて色付けされます。 

Slice Details ダイアログの Contour ページで、等高線作成

に使用されるカラーマップと変数を選択し、スライスに使用

する等高線グループを指定することができます。連続した値

を示すには Flooding（フラッディング）が最も適しているの

で、Flood By ドロップダウンメニューから Pressure グルー

プを選択します。 

使用したい変数が Flood By ドロップダウンメニューにない場合は Multi-Coloring Details ダイアログに移動して

目的の変数を設定してください。このダイアログには Slice Details ダイアログの右側、Flood By ドロップダウン

メニューの隣にある (...) ボタンをクリックすると簡単にアクセスすることができます。同じダイアログを表示して

みてから Contour and Multi-Coloring Details ダイアログを閉じてください。 
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ここで示すように、Pressure（圧力）によってスライスの等高線を表示します。等高線グループは 7 です。 

補足 - 複数のスライスを作成する 

素晴らしいスライスが作成されました。さらに追加してみましょう。作成しようとしているプロットにはこの操作を

適用する必要がありません。そのため、このセクションは補足的内容となっています。必要に応じてスキップしてく

ださい。 

1. Slice Details ダイアログの Definition ページで Show Primary Slice をオフにし、Show Start/End 

Slices をオンにします。 

2. 大体、しかしかなり上から翼をまっすぐ見ているようにプロットを回転させます。表示と垂直になって

いるスライスは、ラインに近い場所に存在するはずです。  

注意: プロットを回転させるには Control キー （Mac の場合は Command）を押し

た状態で、マウスの右ボタンを押しながら移動します。"o" (O の小文字) を入力して

回転の原点を設定します。 

プロットの右上にある orientation axis を利用すると Z 軸がこちらを指していると

きを簡単に確認できることに注意してください。 

3. Start サイドバーを使用して、スライスの開始場所を 0 に設定します。 

4. スライスの終了場所を翼端、およそ 1.16 に設定します。  

5. Show Intermediate Slices チェックボックスをオンにして、スライスの数を 4 に設定します。6 つのス

ライスが表示されます。 
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この時点での Slice Details ダイアログとプロットが以下のように表示されます。 
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Step 4  流線の準備 

Streamtraces はサーフェスの周囲の流れを可視化するのに便利なツ

ールです。volume lines, volume ribbons, and surface lines の 3

種類のトレースを試します。 

必要なスライスは一つのみです。もし前の補足項目で複数のスライス

の作成した場合は Slice Details ダイアログに戻り Show Start/ End 

Slices をオフにして Show Primary Slice をオンにしてください。  

翼端（圧力差が渦放出を発生させる場所）でスライスを行います。 

Slice Details ダイアログで、スライスの Primary location(初期) 位

置に 1.18 と入力してスライスを翼の先に近づけます。 

以下のように Slice Details ダイアログが表示されます。このダイア

ログをしばらく使用しないのであれば、この時点で閉じても問題あり

ません。 

ここで、翼端がほぼこちらを差すように回転させます（Control キー

（Mac の場合は Command） とマウスの右ボタンを押しながらドラッグ）。プロットの右上隅にある方向軸を利用

すると翼を正しい方向に向けやすくなります。およそ以下のイメージように表示されるはずです。 

何が表示されているのでしょうか? 緑色の背景はスライスで、この時点では翼のほとんどが隠れていて翼の先端し

か見えません。 
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最後に、翼周辺の流れの速度を意味するベクトル変数を指定することができます。先にこれを指定しないと、流線が

追加される際に変数の選択を求める画面 Tecplot 360 EX が表示されます。しかし、この機能の存在を知っているだ

けなので、ここで実際に操作してみましょう。 

メニューバーから Plot>Vector>Variables を選択します。Select Variables ダイアログが表示されます。実際には

データ内に速度の値は存在しませんが運動量は存在し運動量のベクトル場は速度と同じです（運動量とは速度と密度

を乗算したものです。次のセグメントで速度の値の計算方法を学びます）。 

そのため、運動量の変数を使用して目的を達成することができます。U、V、W のベクトル変数にそれぞれ、

Momentum U、Momentum V、Momentum W を選択します。   

 

上記のように Select Variables ダイアログが表示された場合は OK をクリックしてください。 
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Step 5  流線のシード 

Plot サイドバーで Streamtraces チェックボックスをオンにし

たら Streamtrace ツールボタンをクリックします（右図参照）。 

マウスでラインを配置しラインに沿って均等に流線をシードできるようになります。ラインを引くには、開始点をク

リックしたまま終了点までドラッグします。翼前縁に沿って以下のようにざっと縦のラインを描いてみてください。 

 

Tecplot 360 EX は、以下に示すように、翼周辺の流れを示す流線が作成されます。スライスのサーフェスでライン

に沿った等間隔のポイント（シーディングと呼ばれます）での質量の無い粒子放出のシミュレーションおよび、流れ

を記述するベクトル変数に基づいた計算が行われ流線が作成されます。 
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流線のいくつかはスライスの後ろに存在します。流線をさらにはっきりと表示するためにスライスの透明度を 40% 

にしてみましょう。スライスを右クリックしコンテキストツールバーの一番右にあるドロップダウンメニューで 40 

を選択します。 
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3 次元でプロットを回転させて流線と翼をさらに見やすくします。結果は大体以下のように表示されます。 
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Step 6  ボリュームリボンのシーディング 

デフォルトでは流線は矢印を伴うシンプルなラインで示されます。リボンを使用すると、2 次元サーフェスを使用し

て局所のねじれが表示されるため、流れをさらによく確認することができます。ボリュームをリボンに切り替えるに

は以下の手順に従います。 

1. Plot サイドバー内の Streamtraces の隣にある  ボタンをクリックして Open the Streamtrace 

Details ダイアログを開きます。ダイアログ内のタブの選択が Placement になっているか確認してくだ

さい。 

 

2. Streamtrace Details ダイアログで Delete All をクリックして既存の流線を削除します。 

3. ダイアログ内の一番上に用意されているドロップダウンメニューで Volume Ribbon を選択します。 

4. Plot サイドバーにある Streamtraces の横の streametrace ツールボタンをクリックします。

Streamtrace Details ダイアログが開いたままですが別の場所に移動します。  

5. 前回行ったように翼前縁に沿ってラインをドラッグし流線をシードしてリボンを作成します。  
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このリボンを伴ってプロットが以下のように表示されます。 

 

白よりも目立つ色に変更してみましょう。色の変更は Streamtrace Details ダイアログの Rod/Ribbon ページで行

います。 
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このダイアログの一番下付近、Show Shade チェックボックスの下部にある Color の横のボタンをクリックしま

す。表示された Color Chooser ダイアログの色見本で赤を選択します。 

 

赤い ribbon のプロットは以下のように表示されます。 

 

Step 7  回転とライティングの調整 

ライティングの方向を調整してリボンをさらに目立たせることができま

す。Plot サイドバーにある太陽のアイコンをクリックしてください。 
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プロットの周りをクリックするかドラッグしてライティングを移動します。そうするたびにリボンがハイライトさ

れる場所が分かります。プロットを回転させて、さらに見やすい表示にすることもできます。 

Step 8  サーフェスの流線 

ここまで、翼の周りの空気（ボリュームの流線およびリボン）を通して流れを見てきました。翼のサーフェスを越え

た流れも可視化することができます。 

明確に言うとこれらの流線は翼周辺のボリュームゾーンからの運動量データを用いて計算されます。実際、翼のサー

フェスゾーンには運動量や速度のデータは存在しません。このチュートリアルに用意されているデータファイルに

は、この処理を正確に行うゾーンの構成があります。 

ボリューム内で流線をシードするラインを描画する翼を指定するためにスライスを

使用しました。サーフェスの流線を作成する場合は直接サーフェス上にシードする

だけです。そのため Plot サイドバーで Slice チェックボックスをクリックしてス

ライスをオフにします。 

次は Streamtrace Details ダイアログの Placement のページで Delete All をクリックして、作成したリボンを削

除しましょう。それから、ダイアログの上部で “Surface Line” を選択します。 
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向こう側が見れるように再び翼を回転させましょう（Control キー（Mac の場合は Command） とマウスの右ボタ

ンを押しながらドラッグ)。以下のような角度になります。 
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いつものようにプロットの右上隅の方向軸を使用すると一定の方向を保ちやすくなります。スライスのサーフェスか

らシーディングしたときのように、Plot サイドバーで Streamtrace ツールを選択して翼の向こう側にドラッグして

先端と平行にします。  Tecplot 360 EX が streamtraces を作成した後、以下のように表示されます。 

 

さらによく見えるようにさらに流線を太くしました。実際に操作して同じように変更する方法を確認してみてくださ

い（Streamtrace Details ダイアログの Line ページで設定します）。 

ひとまず流線についての実践は終わりです。終了したところで Plot サイドバーにある Streamtraces チェックボッ

クスをオフにして流線を非表示にし、翼だけを表示してください。 

Step 9  等値面（Iso-Surface）の作成 

等値面（Iso-surface）は、サーフェスとして等高線変数の定数値を可視化するのに優れた手法です。つまり値を指

定すると、その値で指定した変数の場所が等値面（ iso-surface）に示されます。 

この機能を使用して、翼が音速で通過するときの衝撃波を可視化してみましょう。

Mach 1 に iso-surface を作成します。 

1. Plot サイドバーにある Iso-Surfaces チェックボックスをオンにしま

す。 
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2. Iso-Surfaces の隣にある  ボタンをクリックして Iso-Surface Details ダイアログを開きます。 

ここで、Mach 変数とカラーマップを関連付ける等高線グループを選択する必要があります。しかし、 

Define Iso-Surfaces Using ドロップダウンリストを展開すると 1 が存在しないのが分かります。そ

のため、1 を作成する必要があります。 

3. このメニューの隣にある gear アイコン をクリックして、前に表示したように Contour and Multi-

Coloring Details ダイアログを開きます。 

4. 3 番目の等高線グループを定義するために、このダイアログの上部に表示されたボタンの中から 3 をク

リックします。 

5. ダイアログの上部にあるメニューから Mach 変数を選択します。 

6. Large Rainbow カラーマップを選択します。以下のように表示されるはずです。 
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7. Contour and Multi-Coloring Details ダイアログを閉じます。 

8. Iso-Surface Details ダイアログに戻って Define Iso-Surfaces Using メニューから contour group 3 

を選択し、Value 1 フィールドに 1 の値を入力します。 
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プロットは以下のように表示されます。翼を回転させてさらによく見える位置にしてあります。 

 

この等値面（iso-surface）は、翼周辺を Mach 1 で移動している空気の場所を示します。数値入力フィールドの横

にある矢印で Value 1 を調整してプロットがどのように変化するか確認してみてください。 

これは複数の値で複数の iso-surface を表示するのに有益なことがあります。Mach 1.2 に 2 番目の iso-surface を

追加してみましょう。Draw Iso-Surfaces At メニューを “2 Specified Values” に変更し Value 2 フィールドに 

1.2 と入力します。   
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ダイアログオプションはここに示されます。 

 

2 番目の iso-surface はどこにあるのでしょうか? 1 番目の iso-surface よりもさらに翼近くにあるため隠れていま

す。iso-surface を部分的に透明にして、1 番目の内部にある 2 番目の iso-surface、およびその中でかすかに見え

る翼も見えるようにしましょう。 

プロット内の iso-surface 上で右クリックし、ツールバーの一番右にあるアイコンをクリックして transparency 

（透明度）をオンにします。両方の iso-surface が同じグループ内にあるため、2 つとも透明になります。 
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Mach 1 iso-surface 内の Mach 1.2 iso-surface がに見られるようになりました。プロットを回転させて確認して

ください。これは亜音速と超音速の間で遷移が発生している場所の衝撃面です。最終的に iso-surface プロットは

以下のようになります。 

 

Step 10  Probe データ 

最後はプロービングの手法を検討します。プロービングを使用するとクリックした場所にあるすべての変数の値が表

示されます。画面上部のツールバーで Probe ツールを選択します。 

 

プロット内で任意のポイントをクリックしてください。Probe サイドバーは画面の右端に表示され、それぞれクリ

ックした位置の変数が表示されます。  
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目的の情報 を選択して右クリックするか、Control-C （Mac OS X の場

合は Command-C）を押して、プローブの結果から変数名、値、または

その両方をコピーすることもできます。  

他のサイドバーと同様に Probe サイドバーをワークスペース内の別の場

所に移動したり、他のサイドバーと結合したりすることができます。さ

らに切り離して Tecplot 360 EX のウィンドウから移動し別のモニター

に表示することも可能です。 

前述のように、このセグメントの操作で最終的に示された結果のスナッ

プショットを含む Tecplot 360 EX レイアウト (.lay) ファイルは 

Tecplot 360 EX インストールフォルダ> examples フォルダ> 

OneraM6wing/ finallayouts/ExtenalFlowVideo2.lay  に格納されて

います。 

 

 

2 - 3   CFD シミュレーションデータと実験データの比較 

このセグメントではシミュレーションおよび実験データを使用して標準的な圧力係数（Cp）を作成します。まず、

風洞内の翼と連動して圧力タップから収集された実験データを追加します。次にスライスを抽出して新しいフレーム

内に XY ラインプロットを作成します。 

実験データは翼幅と翼弦の両方で正規化されます（Y 方向は b (翼幅)で、X 方向は c (翼弦)で正規化されます）。シ

ミュレーションデータは正規化されていないため、シミュレーションと比較できるように実験データの一部が調整さ

れます。 

Step 1  レイアウトのロード 

このチュートリアルのセグメント 2 ではなく、セグメント 1 で保留にしておいた箇所から続けます。  Tecplot 360 

EX のインストールフォルダ> examples フォルダ> レイアウト

OneraM6wing/finallayouts/ExtenalFlowVideo1.lay  をロードしてください。 

Step 2  実験データの追加 

Tecplot 360 EX のメニューから File>Load Data を選択して実験データファイルを開きます。これは 

Onera_Experimental.dat と名付けられた Tecplot ASCII ファイルで Tecplot 360 EX の examples ディレクト
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リの OneraM6wing フォルダに格納されています。（ファイルを選択できない場合はダイアログの下部にあるメニ

ューから All Files を選択してください）。1 

All Files を使用するとファイルを使用した後に Choose Loader ダイアログ

が表示され、どのフォーマットを適用するかを確認する画面が表示されます。 

“Tecplot Data Loader” を選択し OK をクリックします。 

次に Tecplot 360 EX は、新規データと既存のデータと置き換える、または

新規データに追加するかを確認する画面が表示されます。 

Load File(s) ダイアログで Append data to active frame をクリックします。  

Step 3  Variable Load and Combine 

データを追加した後、Variable Load and Combine ダイアログが表示されます。このダイアログには、特定の変数

を結合させるオプション、および特定の変数を追加しないようにするオプションが用意されています。自動的に結合

された変数は青色になります。手動で結合した変数は緑色になります。その他の変数は黒です。

Pressure_Coefficient が自動的に結合されたことに注意してください。 

                                 
1 . この実験データは NASA が提供するデータに少し変更を加えたものです。詳細は、以下の URL をご参照ください。

https:// turbmodels.larc.nasa.gov/onerawingnumerics_val.html 

https://turbmodels.larc.nasa.gov/onerawingnumerics_val.html
https://turbmodels.larc.nasa.gov/onerawingnumerics_val.html
https://turbmodels.larc.nasa.gov/onerawingnumerics_val.html
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この例では Experimental データセットから、すべての変数をロードします。Add All を選択したら OK を選択

して、 Variable Load and Combine ダイアログを閉じます。 

データが正しくロードされたか確認するには、メニュー

から Data>Data Set Info を選択して Data Set 

Information ダイアログを開きます。７つの新しいゾー

ンに注目（Section 1 - 0.2, Section 2 -0.44 など）。こ

れらのゾーンには翼に沿って配置された圧力タップから

の実験データが含まれています。 

変数 #19 から始まるいくつかの新しい変数にも気付くで

しょう( TapNumber, X/L, Y/b, Z/L, and Cp Error)。 

 



 2 - 3   CFD シミュレーションデータと実験データの比較 

 

 53 

Step 4  Y を Y/b に正規化する 

圧力タップの位置で実験データとシミュレーションデータを比較をしたいと考えています。しかし、既に述べたよ

うに実験データは正規化されています（シミュレーションデータ内で分かるように 0 から径間長までの範囲である

Y を使用する代わりに、0 から 1 までの範囲である b を越えた Y(Y/b) が使用されています）。 

Data Spreadsheet ダイアログを開き (Data>Spreadsheet)、WingSurface ゾーンを選択し、 “Y/b” 変数をが見

えるようにスクロールすると、シミュレーションデータに当該情報が含まれていないことがわかります。単なる実験

用データセット内でしかありません。 

 

しかし Zone メニューを使用して実験データのゾーンの一つに移動すると、この変数に値が存在することが分かりま

す（Section 1 - 0.2 など）。 
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そのため、シミュレーションデータ用にこの変数を計算する必要があります。この計算には方程式を用います。 

Data Spreadsheet ダイアログを閉じたら Data>Alter>Specify Equations を選択して Specify Equations ダイア

ログを開きます。Onera M6 モデルに関する公開情報から、翼幅 b, は 1.19 であるということが分かっています。

そのため Equation(s) フィールドには以下のように入力します。 

{Y/b} = {y}/1.19 

シミュレーションゾーン内で計算したいのはこの変数だけです。この変数はすでに実験ゾーンに存在するため 

Zones to Alter リストでは FluidVolume and WingSurface のみを選択するように注意してください (Control キ

ーを押しながら （Mac の場合は Command キー）、オン/オフを切り替えるゾーンをクリックします)。以下のよう

に Equations ダイアログが表示されます。 
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Compute をクリックしてシミュレーションゾーンの Y/b 値を計算します。 

翼端でプロービングして処理を確認してみましょう。 

1.Tecplot 360 EX ツールバーにある Probe ツールをクリックします。 

 

2.翼の先端をクリックします。 

3.Probe サイドバー内の Y/b 値を確認します。 

Y/b の値には 1 が想定されます。しかし、翼の先端が傾斜しているた

め実際の Y/b 値は 1 よりも少し大きくなります。すべてがこのとお

りになるはずです。目的を達成しました。 

Step 5  圧力タップの位置でのシミュレーションデータからスライスを抽出する 

次は Y 軸を Y/b に変更しましょう。 Tecplot 360 EX メニューバーから 

Plot>Assign XYZ を選択します。それから Select Variables ダイアログで

Yaxis 変数に “Y/b” を選択します（以下参照）。OK をクリックして変更を保存

します。 

Y 変数を変更するとワークスペース内の翼が回転することがあります。これは

正常な動作です。 

このチュートリアルで扱う実験データには翼の圧力タップでの情報しか含まれていません。この例としてシミュレー

ションデータと Y/b = 0.65 における圧力タップからの実験データを比較します。この場所でシミュレーションの

スライスを作成し、そのスライスを新しいゾーンに抽出します。 
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つまり、圧力タップの場所で翼とともにシミュレーションされたサーフェスデータは新規の 2 次元ゾーンにコピー

されます。手順は以下のとおりです。 

1. Plot サイドバーで Slices チェックボックスをオンにします。 

2. Plot サイドバーの Slices の隣にある  をクリックして Open the 

Streamtrace Details ダイアログを開きます。 

3. Slice Details ダイアログでは以下の操作を行います。 

• Slice Location を Y-Planes に変更する。 

• Show Primary Slice がオンになっているか確認する。 

• Primary Slice の値に 0.65 と入力する。  

• Slice Through の項目を “Surface Zones” に設定する。

 

 

以下のように、翼のサーフェス上のスライスの場所にバンドが表示されます。 
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4. Extract Slices ボタンを選択して、このスライスを新しいゾーンに抽出します。(または、

Data>Extract>Slices の順で選択していきます。)  

5. Extract Slice ダイアログで、すべてデフォルト値のままにして Extract をクリックし、スライスの抽出

を続けます。 

6. Extract Slice ダイアログ、および Slice Details ダイアログを閉じます。 

新規スライスのゾーンは zone 10 で “Slice Y=0.65” と名付けられました。Data Set Information 内でこれを確認

することができます。 

Step 6  スライスの X を X/L に正規化する 

実験データに合致させるため、翼弦に対するスライスの X 次元を正規化することができます。Y 次元の正規化した

ときと同様に Specify Equations ダイアログを使用します。実験データでは変数 X/L として保存されます（興味が

あれば、前に Y/b で行ったように Data Spreadsheet ダイアログでこれを確認することができます）。 

必要な方程式を以下に示します。 

{X/L} = ({x} - MINX) / (MAXX - MINX) 
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実際にこの計算を実行する前には新たな工夫が必要です。方程式は MAXX および MINX の固有変数を使用します。

これらの変数は Tecplot 360 EX によって提供され アクティブなすべてのゾーンにおける最小と最大の X 値を参

照します。翼弦を計算するためにスライスのみの最大Ｘ値と最小Ｘ値が得たいので、この計算を実行している間はほ

かのすべてのゾーンを一時的に無効にする必要があります。 

Plot サイドバーで Zone Style ボタンをクリックして Zone Style ダイアログを開きます。 

 

抽出したスライスゾーンの Show Zone チェックボックスを右クリックし Show Selected Only を選択します。 

 

スライスゾーンを除くすべてのゾーンの横にあるチェックボックスをオフにします。プロットも非表示なりますが問

題ありません。 

Data>Alter>Specify Equations を選択し Equation(s) フィールドに方程式を入力します。もう一度、この方程式

を以下に示します。 

{X/L} = ({x} - MINX) / (MAXX - MINX) 

必要なのはスライスの計算だけなので Zones To Alter リストの下部にリスト表示された新しいゾーン “10: Slice 

Y=0.65” のみを選択するように注意してください。    
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Compute をクリックできるようになりました。 

この計算が終了したら Zone Style ダイアログに戻り、すべての行を選択して無効にしたゾーンに戻り（ショートカ

ット: Control-A または Command-A（Mac））、すべての行を選択して無効にしたゾーンを有効に変更します。これ

で無効にしたゾーンの Show チェックボックスをオンにします。この操作により、選択したゾーンがすべてオンに

なります。 

Zone Style および Specify Equations ダイアログの両方を選択できるようになりました。 

Step 7  スライスの XY プロットを作成する 

スライスの XY プロットを作成する準備ができました。これを独自のフレームに配置します（フレームとは 1 つの

ページに複数のプロットを表示する Tecplot 360 EX の方法です）。 

まず、 Tecplot 360 EX ツールバーにある Frame ツールをクリックします。 

 

次に、これを使用してワークスペース内で新しいフレームを描画します。 Tecplot 360 EX によって即座に適切な設

定が行われるため、配置とサイズを気にする必要はありません。プロット上の任意の場所でマウスをクリックしたま

ま下にドラッグし、作成するフレームの右側に移動します。プロット内で矩形が見えたらマウスのボタンを離しま

す。  

新しいフレームが以下のように表示されます。 
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次に、 Tecplot 360 EX メニューバーから Frame>Tile Frames を選択します。以下のように Tile ダイアログが表

示されます。 

 

ワークスペース内でフレームの上部が積み重なるように Tile Frames ダイアログの右下にあるボタンをクリックし

ます。それから Tile ダイアログを閉じます。  

プロットが以下のように表示されます。 
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Plot サイドバーの上部にあるドロップダウンメニューを使用して Sketch から XY 

Line に変更します。 

Create Mappings ダイアログが表示されます。このダイアログで、X-Axis は X/L 

変数、Y-Axis は Pressure_Coefficient、 Zone は抽出したスライスゾーンに設定

します。目的の設定を以下に示します。 

OK をクリックして以下のようなプロットを作成します。 
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Cp プロットに詳しいユーザーであれば、現在のプロットは何か変だと気づくでしょう。問題は Y 軸があるべき状態

から逆になっているということです。幸いこれは簡単に修正することができます。 

1. メニューバーから Plot>Axis を選択して Axis Details ダイアログを開きます。 

2. 上部にある Y1 をクリックして Y 軸を選択します。 

3. Reverse Axis Direction チェックボックスをオンにします。 

 

4. 以下のような設定が表示されたら Axis Details ダイアログを閉じます。プロットが以下のようになりま

す。より優れたプロットになりました。 
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Step 8  実験データのプロット 

いよいよ最終段階となりました。実験データをプロットに追加しましょう。Plot サイドバーで Mapping Style ボタ

ンをクリックして Mapping Style ダイアログを開きます。 

 

line map は変数とプロットの各ラインの外観を結びつける（マッピング） Tecplot 360 EX 手法です。XY Line モ

ードに切り替えると Tecplot 360 EX が最初のラインマップを作成しました。Mapping Style ダイアログは XY ライ

ンプロットにおけるラインマップを管理するために使用します。 

シミュレーションと実験データの両方をプロットで表示したいので、実験データのために 2 番目のラインマップを

作成する必要があります。最も簡単なのは既存のシミュレーションデータのラインマップをコピーして変更して実験

データに表示する方法です。 

1. Mapping Style テーブルで最初の行をクリックし、1 番目のラインマップを選択します。 

2. ダイアログの下部にある Copy Map ボタンをクリックします。テーブルに 2 番目のラインマップが表示

されます。 

3. テーブルの 2 番目の行にある Zone フィールドを右クリックして、2 番目のラインマップのゾーンとし

て zone 5, “Section 3 - .65” を選択します。これは翼に沿った 0.65 の位置における圧力タップの実験

データで、シミュレーションのゾーンで得たスライスの位置に結び付いています。 
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4. 2 番目のマップの Show Map チェックボックスをオンにします。 

5. 各マッピングの名前をダブルクリックして適した名前を入力します。識別しやすい名前を付けておく

と、プロットの変更をする際に便利です。ここでは以下のように名前を付けました。 

• Map 1: CFD Simulation: Y/b = 0.65 

• Map 2: Experimental: Y/b = 0.65 

Mapping Style ダイアログとプロットが以下のように表示されます。 

 

ご覧のとおり、ここには少し問題があります。シミュレーションと実験データの外観が同じで見分けがつかなくなっ

ています。2 つのゾーンに異なる色を使用することでこれに対処することができます。  

さらに、シミュレーションデータは連続的ですが、実験データは翼に沿った特定のポイントで計測されており、離散

的です。そのため、実験データはラインではなく、各測定箇所にシンボルを用いて表示します。  

最終的に実験データの不確実な情報はエラーバーを使用して表示することができます。  

これらすべての外観は Mapping Style ダイアログによって変更することができます。実行してみましょう。 

1. Mapping Style ダイアログ内の Lines タブを選択したら、Experimental マッピングの Show Lines 

チェックボックスをオフにします。 

2. Lines のページで CFD Simulation マップの line thickness を右クリックしたら 0.40% に変更してさ

らに幅を広くします。 
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Lines ページが以下のように表示されます。

 

3. Mapping Style ダイアログの Symbols ページを指定します。ここ

では、すべての設定がグレーアウトしていることに注意してくださ

い。Symbols 設定を使用するには、Plot サイドバー内の Symbols

チェックボックスをオンにして、プロットのシンボルを有効にする

必要があります。 

4. Mapping Style ダイアログ内で Symbols の設定を有効にしたので 

CFD シミュレーションマップのシンボルはオフにします。 

5. Experimental マップの Outline Color を右クリックして、色見本から青色を選択します。 

6. シンボルが大きすぎるので、このマップの Symbol Size を右クリックして 1.0 に変更します。Symbols 

ページが以下のように表示されます。 
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補足 - Line Map コンテキストメニュー および ツールバー 

既に述べたように、Zone Style ダイアログを使用せずに 3 次元プロットを右クリック

して変更するほうが素早く変更できます。プロットのラインを右クリックして、マップ

コンテキストメニューとツールバー（右側に示されます）を表示します。次のステップ

では、Mapping Style ダイアログではなく、コンテキストメニューを使用してエラーバ

ーを追加してみてください。 

Step 9  エラーバーの追加 

実験データには Onera M6 wing 用に NASA が提供したデータから計算された誤差変数が含まれています。明確に

いうと、圧力タップの測定誤差は±0.02 であることが分かりました。この情報を可視化するためにプロットにエラ

ーバーを追加しましょう。 

1. Mapping Style ダイアログで Error Bars ページを指定します。Symbols ページと同様に、最初はすべ

てのエバーバーの設定は灰色になっています。そのため、Plot サイドバーの Error Bars をオンにして 

Error Bars のレイヤーを有効にし、Mapping Style 内で設定が使用できるようにする必要があります。 

2. Error Bar の設定により Mapping Style ダイアログが利用可能となり、Experimental マップの 

Show Error Bars がオンになります。 

3. このマップの Error Bar Variable を選択して、variable 23: “Cp Error” を選択します。 

4. マップの Error Bar Color を右クリックし、先にマップのシンボルで選択したのと同じ青色を選択しま

す。 

Error Bars のページが以下のように表示されます。 

 

Mapping Style ダイアログを選択できるようになりました。プロットが以下のように表示されます。 
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Step 10  最後に 

最後の仕上げとしてプロットに凡例を追加することができます。  

Tecplot 360 EX メニューから Plot>Line Legend を選択し Legend ダイ

アログを開いたら Show Line Legend チェックボックスをオンにしま

す。 

View>Nice Fit to Full Size も選択して、軸に対するプロットの表示にゆ

とりをもたせます。 
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最終的なプロット（両方のフレームを含む）は以下のようになります。 

 

このチュートリアルの最終結果のスナップショットを含む  Tecplot 360 EX レイアウトパッケージ (.lpk) ファイル

は、Tecplot 360 EX インストールフォルダ内の examples フォルダにある OneraM6wing/finallayouts/ 

ExtenalFlowVideo3.lpk  に格納されています。 

2 - 4   次のステップ 

これで、 Tecplot 360 EX の外部流れのチュートリアルは終了です。User’s Manual や Help (Help>Tecplot 360 

EX Help) を参照して、このチュートリアルで用いた一般的または特定の機能をさらに深く掘り下げたいと思うかも

しれません。 

弊社では定期的に製品の機能を紹介するビデオを作成しており、新規ユーザー向けの導入的トピックだけではなく、

上級ユーザー向けに最新のリリースで追加された新機能を中心としたトピックも紹介しています。Web サイト 

https://www.tecplot.com/category/tecplot-360-videos/?product=360 または、YouTube チャンネル https:// 

www.youtube.com/user/tecplot360/ で参照することができます。

https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.youtube.com/user/tecplot360/
https://www.youtube.com/user/tecplot360/
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3 ボリュームサーフェスについて 

このチュートリアルでは Tecplot 360 EX で Surfaces to Plot を使用したボリュームサーフェスのレンダリング方

法の例を示します。このチュートリアルでは Getting Started Bundle に格納されている duct flow データセットを

使用します。 

このチュートリアルは１つのセグメントのみで構成されます。複雑さのレベルを以下に示します。 

番号とレベル タイトルと説明 

1 - 初級 
ボリュームサーフェスについて - Duct Flow データセットをロードし、Tecplot でボ

リュームサーフェスデータがどのように表示されるかを理解します。 

以下の Web サイトからこのチュートリアルのビデオが視聴できます。 

www.tecplot.com/blog/2016/03/04/ understanding-volume-surfaces/ 

このビデオの内容は印刷されたチュートリアルと少し異なる場合がありますが、同じ内容をカバーしています。 

https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
https://www.tecplot.com/2016/03/04/understanding-volume-surfaces/
https://www.tecplot.com/2016/03/04/understanding-volume-surfaces/
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3 - 1   ボリュームサーフェスについて 

Step 1  Tecplot 360 EX を起動しデータセットをロードする 

Windows の場合は Start メニューをクリック、Linux の場合はターミナルウィンドウに tec360 、Mac OSX の場合

はアプリケーションフォルダ内で目的のアプリケーションアイコンをクリックして Tecplot 360 EX を起動します

（このドキュメントでは Windows バージョンの Tecplot 360 EX の例を示しますが他のプラットフォームでもほぼ

同様に表示されます）。 

サーフェスプロットデータのロードを開始するには、初期画面の上部から Load Data をクリックします。（または、

メニューバーの File ドロップダウンメニューから Load Data を選択するか、ツールバーの左から 2 番目にあるフォ

ルダアイコンをクリックします。この方法は初期画面が非表示の場合に便利です）。  

Load Data ダイアログが表示されます。 

 

Tecplot インストールフォルダ内の examples/SimpleData ディレクトリに移動し、DuctFlow.plt ファイルを選

択します。このファイルを開くと、以下のような 3 次元直交座標が表示されます。 
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Step 2  Surfaces to Plot および Zone Style ダイアログ 

現在、オレンジ色の破線に囲まれた空のボックスが表示されています。これらのラインはスタイルが適用されていな

いボリュームゾーンの境界を示しています。表示されている内容を確認するため、 Zone Style ダイアログの 

Surface タブを見てみましょう。 

• Plot サイドバーから Zone Style ダイアログを開きます。 
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• 上部の Surfaces タブを選択して、Surfaces to Plot の表示を確認します。 

 

パフォーマンス上の理由から、ボリュームゾーンで Surfaces to Plot  のデフォルトオプションは “none” に設定さ

れています。サーフェスデータを表示したいボリュームゾーン がある場合は、このオプションを変更します。サー

フェスゾーンがデータセットにある場合、それらは Zone Style ダイアログで “N/A” と表示されることに注意して

ください。 

Step 3  等高線およびサーフェスデータ 

Plot サイドバーで Contour をオンにします。ただし、等高線を表示するには、 

Tecplot 360 EX は,何らかのサーフェス上で表す必要があります。このデータに含

まれるのはボリュームゾーンのみのため、ボリュームゾーンのサーフェスを表示す

るか確認する Question ダイアログが表示されます。または、plot サイドバーで、

Mesh、Contour、Shade、Vector または Scatter レイヤーオプションを有効にす

ると、アクティブなゾーンでサーフェスをオンにするか確認する画面が表示されま

す。 

ボリュームゾーンのサーフェスをオンにすると、リソースが大量に消費される可能性があります。ボリュームゾーン

全体をロードし、どのセルを外面に表示するかを計算する必要があるためです。 

Question ダイアログで “Yes” をクリックすると、 Tecplot 360 EX Zone Style ダイアログで Surfaces to Plot オ

プションを変更できるようになります。これで、ボリュームサーフェスは軸の変数ではない最初の変数で等高線が描

かれます。 
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Step 4  Zone Style ダイアログでプロットするサーフェスの変更 

Zone Style ダイアログが閉じられている場合、Plot サイドバーで Zone Style ダイアログをクリックして再度、

Zone Style ダイアログを開きます。 

 

Surfaces タブに移動すると、Surfaces to Plot の表示が “Boundary cell faces” に変更されているのが分かり、

表示された境界セルのサーフェスの等高線を確認することができます。 

結果のプロットが以下のように表示されます。Contour 変数を変更していないので、このプロットでは U ベクトル

変数が表示されています。 
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3 - 2   次のステップ 

これで Tecplot 360 EX のボリュームサーフェスチュートリアルは終章です。User’s Manual や Help 

(Help>Tecplot 360 EX Help) を参照して、このチュートリアルで用いた一般的または特定の機能をさらに深く掘り

下げたいと思うかもしれません。 

弊社では定期的に製品の機能を紹介するビデオを作成しており、新規ユーザー向けの導入的トピックだけではなく、

上級ユーザー向けに最新のリリースで追加された新機能を中心としたトピックも紹介しています。Web サイト  

https://www.tecplot.com/category/tecplot-360-videos/?product=360 または、YouTube チャンネル https:// 

www.youtube.com/user/tecplot360/ で参照することができます。

https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.youtube.com/user/tecplot360/
https://www.youtube.com/user/tecplot360/
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4 過渡データ 

このチュートリアルでは、垂直軸の風力タービンデータセットを使用して、Tecplot 360 EX の過渡（時間ベース）

に関する性能を詳しく見ていきます。このデータセットは 127 の時間ステップと、254 の Fluent フォーマットの

個別ファイルで構成されており、時間ステップにはジオメトリ用、およびデータ用の 2 つのファイルが存在しま

す。これらのファイルはサイズがかなり大きいため （ギガバイトを超える圧縮） Tecplot 360 EX のインストール

に含まれません。 Getting Started Bundle をダウンロードして、都合のよい場所で圧縮データを解凍してくださ

い。このチュートリアルは 4 つに分かれています。各セグメントの終わりにはレイアウトファイルが用意されてお

り作業を確認することができます。各セグメントの詳細を以下に示します。 

番号とレベル タイトルと説明 

1 - 初級 

過渡データのロードおよび検討 - 風力タービンシミュレーションデータセットをロー

ドして、Tecplot 360 EX 内でどのように編成されるのかを確認します。流線を追加し

て、画面上にデータセットのアニメーションを作成します。 

2 - 中級 
データの抽出 - Tecplot 360 EX のツールとテクニックを使用して、解析する必要が

あるデータの内容を減らして分かりやすくします。 

3 - 上級 
フーリエ変換を使用した周波数解析 - フーリエ変換を実行して、シミュレーションか

ら周波数領域の情報を抽出し圧力変動の原因を解析します。 

4 - 上級 

計算と等高線のカットオフ - Tecplot 360 EX CFDA アナライザーを使用して、新し

い変数を計算します。Contour Color Cutoff プロパティを使用して、プロット内の関

心のある領域を分離します。 

以下の Web サイトからこのチュートリアルのビデオが視聴できます。  

https://www.tecplot.com/2016/03/25/transient-series-video-1-introduction-transient-data/ 

このビデオの内容は印刷されたチュートリアルと少し異なる場合がありますが、同じ内容をカバーしています。 

https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
https://www.tecplot.com/2016/03/25/transient-series-video-1-introduction-transient-data/
https://www.tecplot.com/2016/03/25/transient-series-video-1-introduction-transient-data/
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4 - 1   過渡データのロードおよび検討 

Step 1  Tecplot 360 EX を起動しデータセットをロードする 

Windows の場合は Start メニューをクリック、Linux の場合はターミナルウィンドウに tec360 、Mac OSX の場合

はアプリケーションフォルダ内で目的のアプリケーションアイコンをクリックして Tecplot 360 EX を起動します

（このドキュメントでは Windows バージョンの Tecplot 360 EX の例を示しますが他のプラットフォームでもほぼ

同様に表示されます）。 

風力タービンデータのロードを開始するには初期画面の上部から Load Data をクリックします。（または、メニュー

バーの File ドロップダウンメニューから Load Data を選択するか、ツールバーの左から 2 番目にあるフォルダアイ

コンをクリックします。この方法は初期画面が非表示の場合に便利です）。LoadD ata ダイアログが表示されます。 

 

データを解凍した windturbineblades フォルダに移動します。このディレクトリにあるすべてのファイルを選択し

ます （例えば、Shift キーを押しながら最初のファイルを選択したら、次は最後のファイルを選択し、 Open をクリ

ック）。(ファイルを選択できない場合はダイアログの下部にあるメニューから All Supported Files を選択してくだ

さい)。 

これらすべてのデータファイルを開くには少し時間がかかります。 Tecplot 360 EX が終了すると、以下のような 

2D Cartesian プロットが表示されます。 
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Step 2  詳細に見る 

ここで、何が表示されているのでしょうか? これは完全な 2 次元流体領域で、風タービンの翼、その周囲の空気を表

しています。さらに分かりやすい表示にしましょう。 

• Plot サイドバーで、Mesh チェックボックスをオンにしてメッシュ

を表示します。メッシュは連結された三角形の集合体であり、これ

らは、シミュレーションで使用された個々のセルです。 

• ズームインします。ツールバーで Zoom ツールをクリックし、マウ

スでプロットの中心に矩形を描画します。以下のような表示になる

まで、この操作を 2～3 回、繰り返します。 



4 過渡データ 

78 

また、ズームするフレームにマウスポインターを置き、マウスの中央ボタンまたはスクロールホイー

ルを押さえたまま、マウスを上下に動かしてもズームすることができます。 

これで、３枚翼の垂直風力タービンの横断面を確認することができます。エアフォイル型から直感できるように白い

部分が翼です。回転方向を推測することもできます（反時計回り）。 

Step 3  データセットの情報を掘り下げる 

読み込んだデータをさらに詳しく見てみましょう。  Tecplot 360 

EX の Data メニューから、Data Set Info を選択し、Data Set 

Information ダイアログを開きます。 

すると、このデータセットの 1000 を超えるゾーンの存在が分かり

ます。それぞれのゾーンは、特定の時点におけるシミュレーション

の領域を表します。 

過渡データに慣れていない場合、ゾーンの数が多く見えるかも知れ

ませんが、計算する場合、時間ステップごとにわずか 9 つのゾーン

です。そして実際ここで、ゾーンを見ると zone 1 と zone 10 が 

dom-1 という名前、zone 2 と zone 11 が dom-5 という名前で

表示されており、9 エントリごとにゾーン名が繰り返されているこ

とが分かります。 



 4 - 1   過渡データのロードおよび検討 

 

 79 

データの詳細: 

• 合計 1143 ゾーン 

• 127 時間ステップ 

• 時間ステップごとに 9 ゾーン 

リストの下のパネルで Time Strand フィールドに注目しながらクリックすると、同じ名前を持つゾーンも同じタ

イムストランドをを持つことが分かります。Time strand  （タイムストランド）は、  

Tecplot 360 EX が、同じ領域を表すゾーンを時間を通してリンクする方法です。 

ゾーンリストをクリックすると、タイムストランド上の各ゾーンの解析時間も確認することができます。想定通り、 

zones 1-9 の解析時間は同じであり、zone 10-18 および、その他も同じように示されます。結果として、9 つのゾ

ーンにおける、各セットは同じ時点を表します。 

Step 4  Zone Style ダイアログにおけるタイムストランド 

Data Set Information ダイアログを閉じて、Plot サイドバーにある ボタン Style ダイアログをクリックし、Zone 

Style ダイアログ (以下参照) を開きます。 

 

各タイムストランドを示す 9 つのエントリが表示されます。(各ゾーン番号の横のアスタリスク記号は、単一のゾー

ンではなく、同じタイムストレンドをもつゾーンのグループであることを示しています)このように、Zone Style 

ダイアログを使用すると、各時間ステップで個別に変更するのではなく、始めから終わりまですべて同時に “same  

zone（同じゾーン）” に変更することができます。そのため、データには技術的には何百ものゾーンがありますが、 

Tecplot 360 EX により、9 ゾーンのみ存在しているように表すことができます。 

Zone Style ダイアログでの操作は終わりましたので、このダイアログを閉じます。 

Step 5  等高線プロットの可視化 

プロットを右クリックして、コンテキストツールバーを表示します（右図参照）。このツールをバーを使用して、選

択したゾーンに変更を加えることができます。  
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左から右へ Mesh （メッシュ）、 Contour (等高線)、Vecto （ベクトル）、Shade （陰影）、Edge (エッジ) のアイ

コンが用意されています。最初のアイコンをクリックして Mesh レイヤーをオフにして、２番目の Contour レイヤ

ーをオンにします。（Plot サイドバーでも、この操作を行うことができます） 

 

プロットが以下のように表示されます。 
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Step 6  流線で流れを可視化する 

Tecplot 360 EX で流線を追加することで、風力タービンを通る流れを容易に可

視化することができます。Plot サイドバーで、Streamtraces チェックボックス

をオンにします。(右図) 

Select Variables ダイアログが表示され、流体からの速度を表す変数を選択する

ことができます。デフォルトで Tecplot 360 EX が選択される内容で問題ありま

せんので、OK をクリックしてください。 

vector variables (ベクトル変数) を選択したら、Streamtraces チェックボッ

クスの隣の Plot サイドバーで、streamtrace ツールを選択します。 

これで、プロットに流線を追加する準備ができました。このプロセスはシーデ

ィングと呼ばれます。これは、rake  と呼ばれる、ラインに沿った等間隔の多

数のポイントをシードするのに便利です。 

これを行うために、タービン上部翼付近のプロットをクリックし、マウスボタンを押したまま、下部の 2 つの翼の間

を下にドラッグします。Tecplot 360 EX は配置したラインに沿って、等間隔なポイントに 10 の流線をシードしま

す。そして、 Tecplot 360 EX は、各シードポイントから、前後に無質量粒子のパスを計算し、プロットにパスを描

画します。 
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同じ方法でさらに rake を配置して、追加の流線をシードしたり、クリックしたりして各ポイントをシードすること

もできます。このチュートリアルのセグメントにおける最終結果のスナップショットを含む Tecplot 360 EX layout 

(.lay) ファイルは Getting Started バンドルの WindTurbineBlades/FinalLayouts/transient_1.lay に格納され

ています。 

Step 7  プロットのアニメーション表示 

Plot サイドバーで Play ボタンをクリックすると、タービン翼の回転に伴う圧力と

流体の変化を確認することができます。(先ほど翼の形状から推測したように、タ

ービンは反時計回りに回転します)  
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補足: アニメーションの速度 

アニメーションの速度は Time Animation Details ダイアログで制限

することができます。このダイアログは Plot サイドバーのアニメーシ

ョンコントロールの隣にある  ボタンをクリックして表示されま

す。 

アニメーションの最大速度は Tecplot 360 EX が描画できる各フレー

ムの速度で制限され、この速度は使用しているコンピュータの速度お

よび、すでにメモリ内にロードされているデータ量に依存します。た

だし、Limit Animation Speed チェックボックスをクリックし、任意

のフレーム数/秒を入力して、アニメーションが速くなりすぎるのを制

御することはできます。 

4 - 2   データの抽出 

このエクササイズでは、抽出の手法を説明します。この手法を使用すると、特定の場所のデータの詳細を可視化し

て、知りたいことに焦点を当てて確認することが可能です。まずは、データをラインプロットに一回で抽出します。

次に、経時的な単一ポイントを時系列プロットに抽出します。 

しかし、開始する前に Plot サイドバー内の Streamtraces チェックボックスをオフにして、前のエクササイズの最

後で追加した流線をオフにして、初期のデータに戻します。再度、プロットが以下のように表示されます。 
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次のエクササイズで、正しくこの場所に戻れるように、この時点のレイアウトを保存します。 

Step 1  縦線を作成する 

圧力データを抽出するラインを描画するには、まず、 Tecplot 360 EX ツール

バーにある polyline geometry ツールをクリックします。geometry はプロ

ットに表示される形状です。この特別な geometry ツールは、線と多角形の

両方に使用できるため、名前が polyline となっています。 

描画するラインは、前のセッションで流線を作成するために配置した rake と大体同じ場所にあります。しかし、

polyline ツールは、単純なラインと、より複雑な形状の描画に使用できるため、そのツールとは別の動作をします。 

ラインを配置するには、以下の手順に従います。 

• タービン翼の最上部のすぐ下にマウスのポインターを置いてクリックしたら 離します。Polyline ツール

では、マウスボタンを押したままドラッグしないでください。 

• キーボードで V キーを押して、ラインを縦に制約します。これで、ユーザーは完全に垂直なラインを作

成しているか心配する必要はなくなりました。 Tecplot 360 EX によって制御されます。 

• 緑色の領域の下部にマウスを移動します。ポインターの後に黒いラインが続くことが分かります。どんな

にマウスを垂直に移動しても、ラインはそのままです。 
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• ラインの作成を終了するには、マウスをダブルクリック します。(シングルクリックした場合は、マウス

を移動し、最初に付加した追加のラインセグメントを作成することができます) 

プロットには大体、以下のようなラインが表示されます。分かりやすいようにラインを太くしました。同じにする必

要はありませんが、時間があれば、方法を確認してみてください。 

 

Step 2  経時的にラインを抽出 

 Y coordinate vs. pressure のプロットのアニメーションを作成することにより、ラ

インとともに圧力が経時的に どのように変化するかを見てみましょう。これを行う

には、Data メニューの Extract サブメニューから Extract Polyline Over Time を

選択します。 

単一のタイムステップに興味がある場合は、ラインを右クリックし

てコンテキストメニューから Extract Points を選択します。 

ラインに沿って抽出するポイントの数を確認するメッセージが表示されます。デフォルトの値、100 で問題ありま

せん。 
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Tecplot 360 EX によって、すべての時間ステップを調べて、この

ラインに沿ったデータを抽出するには少し時間がかかります。

Data Set Information ダイアログを開くと、“Extracted Points” 

と名付けられ、ゾーン番号 1144 で始まり、ゾーン番号 1270 で終

わる 各時間ステップの新しいゾーンを見ることができます。   

先にファイル内のデータを確認したときに見たように、それぞれの

新規ゾーンに正確な解析時間が割り当てられ、他のゾーンに接続す

るためのタイムストランドが与えられます。  

新規ゾーンは 127 で、ファイル内の時間ステップの数と一致しま

す。これらの新規ゾーンはすべて、タイムストランド 10 に割り当

てられます。これは以前、時間ステップごとに 9 つの変数が存在

し、ゆえに、9 回 のストランドが存在したためで、当然の結果と

言えます。また、それぞれの新規ゾーンが、以前から存在していた

ゾーンの変数名を持つことも確認することができます。  

想定通り、経時的にデータを抽出しました。 

Step 3  圧力のラインプロットを作成する 

ラインプロットを作成して、抽出ラインに沿って圧力がどのように見

えるか確認してみましょう。このラインプロットは、等高線プロット

と隣合わせで表示することが可能です。また、それらを一緒にアニメ

ーション化することもできます。 

最初に Tecplot 360 EX ツールバーで New Frame ツールを選択しま 

す。次に、マウスボタンを押したまま、プロット上で矩形にドラッグします。場所はどこでも構いません。次のステ

ップでこのサイズと場所を変更します。新規フレームが左図のように表示されます。 



 4 - 2   データの抽出 

 

 87 

 

この新規フレームを適所に配置しましょう。Frame メニューから Tile Frames を選択し、

右下のボタンをクリックします。これにより両方のフレームがワークスペースの幅に拡張さ

れ、以下の図のように上下に配置されます。 
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トップフレームを少し縮小し、風力タービン全体が見えるように位置を調整しま

しょう。これを行うには、ツールバーに用意されている Zoom および Translate 

ツールを使用します。 

• Translate ツールを選択し、トップフレームのプロットをドラッグして、中央に配置します。 

• Zoom ツールを選択し、Control キーを押しながらプロットをクリックして、1 ステッププロットを縮小します。 

トップフレームが以下のように表示されます。 

 

次はボトムフレームに目を向け、このフレームで前にプロットに配置したラインに沿って圧力のラインプロットを作

成します。 

• Tecplot 360 EX ツールバーから、セレクターツール（矢印）を選択し、ボトムフレームをクリックして選択しま

す。 

• Plot サイドバーのトップにあるメニューを使用して、プロットモードを 2D 

Cartesian に変更します。 

この類のデータの場合、XY ラインプロットの使用を検討するでしょうし、一般

にはそれが可能です。しかし、XY プロットには 2D Caresian plot （2D 直交座

標）の過渡機能はありません。 

ボトムフレームでは、最初にこのデータセットを開いたときに表示されたプロッ

トとよく似た灰色の円が表示されます。 

• Zone Style ダイアログを使用して、 Extracted Points （抽出ポイント） ゾーンを除くすべてのゾーンをオフに

します。Plot サイドバーで Zone Style ボタンをクリックします。Show Zone 列の最後に示されたゾーンを右ク

リックし、 Show Selected Only を選択します。 
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このゾーンには各番号にアスタリスクが付き、先に Data Set Information ダイアログで見たように、それがタイ

ムストランドであることを示しています。ゆえに、このゾーンだけの表示にした場合、すべての時間ステップで表

示されるのはこのゾーンのみになります。 

操作を行った後は、Zone Style ダイアログを閉じます。 

• 軸に変数を割り当てるため、Plot メニューから Assign XY を選択します。

それから、以下の図のように、X 軸と Y 軸に、変数 Y と Pressure を選択

します。 

この時点で、ラインプロットはまだ空白のままに見えます。 

• Plot サイドバーの Mesh チェックボックスを選択してラインを表示しま

す。  

軸が正しく設定されていないため、プロットの左側に沿ってすべてが縮みます。次はこれを処理します。 

• Plot メニューから Axis を選択して、Axis Details ダイアログを開きます。以下のように、X 軸の Dependency 

ラジオボタンを Independent に設定します。 
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Tecplot 360 EX に軸の範囲を選択させます。Axis Details ダイアログを開いたまま、 Tecplot 360 EX ウィンド

ウの View メニューから Data Fit を選択します。(Control-F を押すだけでも可能) 

• Data Fit 操作も Y 軸の範囲を設定しましたが、最初の時間ステップの Y 軸の範囲のみが考慮されました。最初の

時間ステップでの Pressure の範囲は、すべての時間ステップを示しません。そのため、適切な Y 軸の範囲を手

動で指定します。  

Axis Details ダイアログ上部のボタンを使用して Y 軸に変更します。それから、minimum および maximum に 

-100 および -30 と入力します。 

 

• Axis Details ダイアログを閉じます。 
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ボトムフレームのプロットは以下のように表示されます。 

 

Step 4  時間ステップのリンクおよびプロットのアニメーション表示 

Plot サイドバーで Play ボタンを押してプロットのアニメーション表示を試すと、

アクティブなフレームのみがアニメーション表示されることがわかります。両方

のフレームを一緒にアニメーション表示するには、それらをリンクさせて、同じ

時間ステップで表示するようにします。 

Frame メニューから Frame Linking を選択し、Set Links for Active Frame ダイアログを開きます。 

 

Between Frames ページで、Solution Time チェックボックスをチェックし、Apply Settings to All Frames of 

this Group ボタンをクリックします。ダイアログを閉じて、再度アニメーションを実行してみましょう。 

補足: 解析時間キャプションの追加 

プロットのサイドバーを見ることなく、プロット上で解析時間が正しいかを判断できると便利です。動画のエクスポ

ートでは特に便利でしょう。これを行うには、以下の手順に従います。 
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• Tecplot 360 EX ツールバーで Add Text ツールをクリックします。 

• テキストを表示したいプロット上でクリックします。 

すると、Text Details ダイアログが表示され、テキストを入力し、フ

ォーマットを選択することができます。 

• Text Details ダイアログに Solution Time:  &(SOLUTIONTIME) と入力します。 

アンパサンドで始まるテキストは、動的テキストのプレースホルダーです。Tecplot 360 EX は、このテ

キストがプロットに表示されるとき、現在の解析時間に置換されます。 

 

• Accept をクリックして、Text Details ダイアログを閉じます。 

再度アニメーション表示して、解析時間の変更を確認してください。 

Step 5  時系列プロット 

各時間ステップにおける圧力を示すラインプロットの作成方法を見てきました。アニメーションを使用して、経時的

な変化を表示することができます。ここで、単一ポイントにおける圧力の変化を表示する 1 本のラインプロットを

作成して次元を減らします。 

この時系列プロットを作成するには Tools メニューから、 Probe to Create Time Series Plot を選択しできる限り 

0 の近くをクリックします（0 は等高線プロット（トップフレーム）で取得可能）。ヒント: マウスカーソルの X 座

標と Y 座標は、 Tecplot 360 EX ワークスペースの右下隅に表示されます。 

クリックすると、 Tecplot 360 EX は少し時間をかけて、すべての時間ステップのそのポイントの圧力値を集めて、

等高線プロットに重ねた新規フレームに時系列プロットを表示します。 
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アニメーション表示すると、現在の時間ステップを示す垂直移動線が表示されます。 

 

3 つのすべてのプロット (等高線プロット、圧力ラインプロット、時系列プロット) が同時にアニメーション表示さ

れます。 

前に使用した Tile Frames ツールを使用して、３つのフレームの配置を調整してみてください。等高線上での再配

置と縮小が必要になる場合があります。 
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4 - 3   フーリエ変換を使用した周波数解析 

先ほど作成した時系列プロットから確認できるように、経時的に圧力が変化します。このエクササイズでは、フーリ

エ変換を使用して、データ内の圧力波の基本周波数を解析し、プローブ位置を変更するとこの周波数がどのように変

化するかを確認します。 

開始する前に、中央のフレーム (線に沿った圧力を示す) を削除しましょう。最初に、ツー

ルバーにある slector tool (矢印) を選択します（選択されていない場合）。そして、中央の

フレームの端をクリックして選択し、キーボードの Delete キーを押します。 

最後に Frame メニューから  Tile Frames を選択し、フレームを並べなおします。等高線プロットを拡大、および/

または、中央に再配置することができます。プロットがこのように表示されます。 
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Step 1  フーリエ変換 

Selector (矢印) ツールで、(時系列プロットを含む) ボトムフレームを選択し、Data メニューから Fourier 

Transform を選択します。Discrete Fourier Transform ダイアログが表示されます。 



4 過渡データ 

96 

 

このダイアログで Dependent variable (従属変数) に Pressure、Source zone (ソースゾーン)  に Time Series 

Plot Zone を選択します。Plot Placement ドロップダウンメニューを使用して、新規フレームの配置に with 

existing frames (既存のフレームと並べる) を選択します。他はすべて同じままにします。Transform をクリック

して、フーリエ変換を実行します。 

X 軸に Frequency (Solution Time)-1 、および Y 軸に Amplitude (Pressure) が示された新規プレームが表示され

ます。 

 

先に進む前に、このプロットを見ると 5 Hz 辺りで低周波スパイクが存在し、77 Hz 辺りで高周波スパイクが存在

するのを簡単に確認することができます。これは、低周波 (低周期) ウェーブに高周波(高周期)ウェーブが重ねられ

ており、時系列プロットで見た内容と合致します。この組み合わせにより、時系列プロットが少しギザギザに見え

ます。 

アニメーションを見ると、低周波圧力の変化の原因は翼の動きにあると考えることができます。とはいえ、高周波の

変化に関する明確な原因は分かりません。 
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Data Set Information (Data > Data Set Info ) に移動し、実際に Fourier Transform (フーリエ変換) がデータセ

ットに行った内容を手短に確認してみましょう。Fourier プロットフレームが選択されていることを確認します。 

 

ご覧のとおり、Tecplot 360 EX は時系列プロットをもとに、新しいフーリエ変換ゾーンを作成し、変数 37 から始

まる、3 つの新しい変数を追加しました。(他のゾーンおよび最初の 36 変数は、時系列プロットを作成したときに生

成されました)  

新しい変数は、フーリエ変換から出力される、Frequency、Amplitude および Phase です。従属変数に Pressure 

のみを選択して変換しましたが、さらに多くの従属変数を選択していたら、それぞれの従属変数に 3 つの新たな変

数が作成されているはずです。 

Step 2  新しい位置での再解析 

何が高周波を引き起こしているのか解明できるか見てみましょう。そのために、タービンの外側、左インレットの近

くで再プローブします。そして、新たに時系列プロットを作成し、フーリエ変換をやり直します。 

等高線プロットを縮小して、タービン周囲の大部分、またはすべての流体領域が見えるようにします。プロットの中

央で、翼が非常に小さくなります。右側では、かなり縮小したのが分かります。プローブする場所付近にマウスポイ

ンターが置かれます。 
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次は Tools メニューから、 Probe to Create Time Series Plot を再度選択し、プロットに示された位置の近くをク

リックします。新しい時系列プロットが作成されます。 

 

すぐに、このプロットの規則性が認識しにくいことが分かります。 

フーリエ変換プロットは、古い時系列プロット内のデータから計算されたため消えます。しかし、このプロットは簡

単に再作成することができます。時系列プロットのラインの上を右クリックすると、コンテキストメニューとツール

バーが表示されます。メニューから Fourier Transform を選択します。 
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前に Discrete Fourier Transform ダイアログで設定したオプションを使用して、新しいフーリエ変換プロットが作

成されます。プロットは以下のように表示されます。 

 

ここで、主要周波数は前に見た 77 Hz 辺りです。5 Hz 辺りの低周波数はもう存在しません。これは、タービン翼の

影響を回避するため、十分な距離をとってプローブしていることを示しています。結果として、周波数 77 Hz が入

力境界条件と判断することができます。  

このチュートリアルのセグメントにおける最終結果のスナップショットを含む Tecplot 360 EX layout (.lay) ファ

イルは Getting Started バンドルの WindTurbineBlades/FinalLayouts/transient_2.lay に格納されています。 

操作してみましょう 

Turbulent Viscosity (乱流粘性) など、他の変数を解析してみてください。渦の放出の近くをプローブすることで、

乱流粘性の変化は、いかにタービン翼のみに起因しているかを確認することができます。次のエクササイズでは、こ

の点についてさらに詳しく検討します。 
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4 - 4   計算と等高線のカットオフ 

Tecplot 360 EX の CFD 解析ツールには、多くの優れた機能が用意されています。最も重要な機能の 1 つに、実際

にデータセットに存在しない、一般に必要な変数を計算する機能があります。ソルバーは、データセットにある値か

ら簡単に導き出せるときに、例えば、なぜ渦度を計算 (および、これらの値を格納してディスクスペースを消費) し

たのでしょうか?  

さらに、Tecplot 360 EX はこれらの値をオンデマンドで計算することができ、可視化の選択をするまで、これらの

計算に時間が費やされることはありません。これはつまり、プロット内の渦度を使用するまで、計算する必要はない

ということです。また、例えば変数がプロットで使用されている場合でも、時間ステップを実際に表示するまで、所

与の時間ステップの変数は計算されません。(ただし、一度計算すると値がメモリに残るため、通常は時間ステップ

に戻ってももう一度計算する必要はありません)そのため、データセットで 10 または 15 の時間ステップだけを見る

のであれば、calculate-on-demand の使用により、渦度の計算にかかる時間の 90%を省くことができます。 

このエクササイズでは、 Tecplot 360 EX CFD 解析ツールを使用して、Vorticity Magnitude(渦度) を計算します。

そして、等高線カラーのカットオフを調整して、プロットの関心領域を分離します。 

このエクササイズで必要なのは、等高線プロットのみです。時系列プロットおよび、前のエクササイズで作成したフ

ーリエプロットを含むフレームを削除して、等高線プロットのフレームがワークスペース全体に表示されるように配

置変更することができます。必要に応じて再度、拡大および中央揃えします。 

Step 1  フィールド変数の設定 

新しい変数を計算する前に Field Variables ダイアログで、ベースライン変数が割り当てられていることを確認する

必要があります。このダイアログを開くには、Analyze メニューから Field Variables を選択します。 

 

Tecplot 360 EX により、ユーザーの目的に合ったデフォルトが選択されました。 

• Convective Variables (対流変数) の U に X Velocity 、V に Y Velocity が選択されています。 

• Pressure および Density が、対応する state variables (状態変数) に選択されています。 



 4 - 4   計算と等高線のカットオフ 

 

 101 

このデータセットには、これらのデフォルトが適切なので OK をクリックします。他のデータセットの場合は、別

の変数を選択する必要があるかもしれません。 

Step 2  渦度を計算する 

渦度を計算するには Analyze メニューから Calculate Variables を選択します。Calculate ダイアログが表示されま

す。 

Select  ボタンをクリックして、計算する変数を選択します。これによ

り、Select Function ダイアログが表示されます。 

見て分かるように、多くの変数を Tecplot 360 EX によって計算するこ

とができます。リストで Vorticity Magnitude を選択したら OK をクリ

ックして Calculate ダイアログに戻ります。Calculate ダイアログのデ

フォルトオプションはそのままで問題ありませんので (Calculate on 

Demand チェックボックスがチェックされていることを確認してくださ

い) 次に進んで、Calculate をチェックします。 

Tecplot 360 EX により、Vorticity Magnitude に calculate-on-

demand が設定され、データセットに変数が追加されます。そして、ア

ラートによって実行内容が表示されます。 

Calculate ダイアログを閉じます。 

Step 3  等高線プロット上で渦度を表示する 

新しく計算された変数をプロットに実際に表示するには、Plot サイドバー内の 

Contours チェックボックスの隣にある  ボタンをクリックして Contour 

Details ダイアログを開きます。Contour Details ダイアログが表示されます。 
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Contour Details ダイアログでは以下の操作を行います。 

• ダイアログの上部のメニューで Vorticity Magnitude を選択しま

す。 

• Set Levels ボタンをクリックして、Enter Contour Levels ダイア

ログを表示します(右図参照)。 

このダイアログで以下の操作を行います。 

• Level Creation Mode に “Exact levels” を選択します。 

• Range Distribution に “Min, max and number of levels” を選

択します。 

• Minimum に 0、Maximum 50、および Number of levels に 21 

を入力します。右図のようにダイアログが表示されたら、 OK を

クリックします。 

Contour Details ダイアログを横に移動して、プロットをよく見えるようにすることができます。ただし、このダイ

アログは次にまた使用しますので、開いたままにしておいてください。 

等高線プロットが以下のように表示されます。 
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Step 4  カットオフの調整 

これは優れたプロットではありますが、臨界値を超える渦度を色付けし、より渦度の高い場所の影響を改善するだけ

で、さらに優れたプロットにすることができます。 

Contour Details ダイアログに戻り、Cutoff below の値に 7 を入力します。このフィールドは、ダイアログの右下

部分にあります。 

 

これにより、7 未満のすべての輪郭が除去され、渦が際立ちます。少し低い値や高い値を試して、少し変化するのを

確認してください。凡例がプロットの region of interest と重なっているので、これを削除しなければなりません。 
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Step 5  プロットを完成させる 

最後にもう一度、Contour Details ダイアログに戻ります。ダイ

アログの Legend ページに切り替えて、Alignment を 

Horizontal に切り替えて Resize Automatically チェックボッ

クスをチェックします。 

Contour Details を閉じます。Selector 矢印ツールを選択し、

凡例ボックスの周囲をクリックして選択したら、プロット上部

中央にドラッグします。 

ツールバーの translation ツールを使用して、風力タービン翼を

少し左に移動すると、発している渦をさらに見ることができま

す。 

マウスの右ボタンを 押しながらドラッグして、プロ

ットを移動することができます。この操作は、任意

のツールがアクティブなときに行うことができま

す。 
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最終の渦度プロットが以下のように表示されます。 

このチュートリアルのセグメントにおける最終結果のスナップショットを含む Tecplot 360 EX layout (.lay) ファ

イルは Getting Started バンドルの WindTurbineBlades/FinalLayouts/transient_3.lay に格納されています。 

Step 6  アニメーションで表示する 

Plot サイドバーで Play ボタンをクリックすると、プロットのアニメーションを開

始することができます。 

まず、アニメーションが若干遅いことに気付くでしょう。これは、前述のよう

に、渦度がオンデマンドの計算変数であるためです。それぞれの時間ステップが

プロットされるたびに、最初にこの変数を計算するには、少し時間がかかります。  

1 回目の再生が終わると、K のアニメーションが繰り返されます。渦度 (Vorticity Magnitude) 変数は時間ステップ

で既に計算されているため、再計算する必要はありません。そして 2 回目以降では、アニメーションの動作がより

迅速かつスムーズになります。 
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4 - 5   次のステップ 

これで Tecplot 360 EX における過渡チュートリアルは終章です。User’s Manual や Help (Help>Tecplot 360 EX 

Help) を参照して、このチュートリアルで用いた一般的または特定の機能をさらに深く掘り下げたいと思うかもしれ

ません。 

弊社では定期的に製品の機能を紹介するビデオを作成しており、新規ユーザー向けの導入的トピックだけではなく、

上級ユーザー向けに最新のリリースで追加された新機能を中心としたトピックも紹介しています。Web サイト 

https://www.tecplot.com/category/tecplot-360-videos/?product=360 または、YouTube チャンネル https:// 

www.youtube.com/user/tecplot360/ で参照することができます。 

https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.youtube.com/user/tecplot360/
https://www.youtube.com/user/tecplot360/
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5 有限要素解析 

このチュートリアルでは LS-DYNA で作成されたコネクティングロッドの過渡 FEA データセットを使用します。コ

ネクティングロッドデータには、ポイントを中心に回転するロッドの LS-DYNA から、32 の異なる変数を伴う 32

時間のステップが含まれています。データは Getting Started Bundle からダウンロードすることができます。 

Finite Element Analysis（有限要素法）チュートリアルは、3 つの異なるセグメントで構成されています。これら

のセグメントで、回転ロッドの Von Mises Stress (ミーゼス応力) を可視化する、さまざまな方法を検討します。各

セグメントの終わりにはレイアウトファイルが用意されており作業を確認することができます。各セグメントにおけ

る総合的な難易度、説明、機能を以下に示します。  

番号とレベル タイトルと説明 使用される機能 

1 - 中級 

サーフェスに沿ってミーゼス応力を計算する - コ

ネクティングロッドデータセット等高線のミーゼ

ス応力を計算して、高応力の領域を見つけます。 

• Animation 

• Color Cutoff 

• Contour 

• FEA Post-Processing 

• Value Blanking 

• 3D マルチフレーム 

2 - 中級 

If ステートメントによるデータ変更 - if ステート

メントを使用して、応力しきい値が交差する場所

を計算します。 

• Data Alter 

• Zone Style 

3 - 中級 

経時的 最大応力のプロット - マクロを使用して最

大応力を経時的にプロットし、フレーム間の解析

時間をリンクします。  

• Frame Linking 

• Macro Commands 

• XY Plotting 

以下の web サイトからこのチュートリアルビデオが視聴できます: https://www.tecplot.com/category/tecplot-

360-videos/finite-element-analysis/  

このビデオの内容は印刷されたチュートリアルと少し異なる場合がありますが、同じ内容をカバーしています。この

チュートリアルの 3 番目のセグメントでは、視覚的なステップがほとんど含まれず、文書で詳しく説明しているため、

ビデオには含まれていません。 

https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
https://www.tecplot.com/category/tecplot-360-videos/finite-element-analysis/
https://www.tecplot.com/category/tecplot-360-videos/finite-element-analysis/
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5 - 1   サーフェスに沿ってミーゼス応力を計算する 

このセクションでは、コネクティングロッドデータセットと等高線のミーゼス応力を計算して、高応力の領域を見つ

けます。 

Step 1  データセットをロードする 

コネクティングロードデータのロードを開始するには初期画面の上部から Load Data をクリックします。（または、

メニューバーの File ドロップダウンメニューから Load Data を選択するか、ツールバーの左から 2 番目にあるフォ

ルダアイコンをクリックします。この方法は初期画面が非表示の場合に便利です）。Load Data ダイアログが表示さ

れます。 

 

ダウンロードして解凍した Con_Rod folder フォルダに移動して、ダイアログの右下にあるメニューを開き、 

select All Supported Files を選択します。D3PLOT ファイルをロードします。 
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ロードしたデータには、オレンジ色の点線で描かれたボックスのみが表示され、Plot サイドバーで Contour を選択

し、表示される question ダイアログボックスで Yes を選択します。すると、プロットが上図のように表示されま

す。3 - 1 ボリュームサーフェスについて でプロットするサーフェイスオプションについて学習します。 

Step 2  アニメーションを遅くする 

プロットのサイドバーで、  play ボタンを押してマシン部が動作していることを確認します。アニメーションが

速すぎる場合は、animation スライダーの上部にある  ボタンを押して、“Limit animation speed to” の横のチ

ェックボックスをチェックし、アニメーションを 12 フレーム/秒に制限します。  

これで、次に Play ボタンを押したときに表示されるアニメーションの速度が遅くなります。Time Animation 

Details ウィンドウを閉じます。 
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Step 3  ミーゼス応力を計算する 

Data>Data Set Info... を選択して Data Set Information ウィンドウを開き、データ構成を確認します。各ゾーン

は異なる時間ステップに属し、同じ変数を持ちます。変数ボックスで、各方向の応力成分がデータセット (変数 10-

15) に含まれていることが分かります。これにより、ミーゼス応力を計算することができます。 

 

次に、Tools>FEA Post-Processing を選択して “FEA Post-Processing Window” を開きます。Derive Variables セ

クションで “Stress” から “Von Mises Stress/Strain” を抽出します。(以下 Stress variables 参照)。 Add to Data 

Set をクリックします。Data Set Information ページで Von Mises Stress (ミーゼス応力) が、変数 33 で表示さ

れます。FEA Post-Processing ダイアログを閉じて、Data Set Information ダイアログを閉じます。 
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Step 4  ミーゼス応力による等高線 

等高線の作成を開始するには、plot サイドバーの Contour チェックボックスの隣に

ある  ボタン を選択し、Contour & Multi-Coloring Details ダイアログを開きま

す。現在、X Acceleration が最初の等高線グループの等高線変数となっています。ダ

イアログ上部のドロップダウンボックスを選択して、contour group variable を 

Von Mises Stress に変更します。  

Tecplot 360 EX では、8 つの等高線グループが使用可能で、各グループは独自の等高線変数とレベルを持ちます。

これにより、複数の等高線のサーフェスを同時にプロットすることができます。このチュートリアルでは、等高線の

プロットに必要なサーフェスは一つだけです。  
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次に Set Levels... button を選択し、minimum level を 0 に、 maximum level を 900 に変更します。そして、 

number of levels を 21 に変更します。結果の Enter Contour Levels ダイアログが以下の図のように表示されま

す。OK をクリックします。Contour & Multi-Coloring Details dialog を閉じます。 

 

Step 5  コネクティングロッドを分離する 

現在、クランクシャフトとシリンダーが、コネクティングロッドの表示の邪魔になっています。データセットが 1 

つのゾーンと多くの時間ステップで構成されているため、Value Blanking の使用により、コネクティングプロット

をさらに明確に表示することができます。ツールバーから Plot>Blanking>Value Blanking を選択し、Value 

Blanking ウィンドウを開きます。Blank when セクションで、ブランキングの制約を Von Mises Stress、is equal 

to 0 に変更します。Include Value Blanking チェックボックス および Active チェックボックス を選択して、現在

のブランキング制約を有効にします。これで、コネクティングロッドのみが表示されます。Value Blanking ダイア

ログを閉じます。  
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Von Mises stress (ミーゼス応力) の等高線値が、クランクシャフトとシリンダーで０と等しいため、結果として示

されるプロットでは、コネクティングロッドが分離されます。データセット内にパーツがまだ残っていますが、こ

れらから有用な情報は得られません。Value Blanking ダイアログでは、複数の制約を同時に有効にすることが可能

で、極めて特別な領域を表示するようにプロットを制限することができます。この場合、必要な制約は 1 つのみで

した。 
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Step 6  クリティカルな破損しきい値を確認する 

Play ボタンを再度クリックすると、 Von Mises Stress (ミーゼス応力) は、サイクルにおける、さまざまなステッ

プで 0 から 900 の間で変動します。対象となる値は Von Mises Stress (ミーゼス応力) が 800 を超える場合の値

です。これはクリティカルな破損しきい値です。クリティカルな破損しきい値を強調表示するには、Contour & 

Multi-Coloring Details ダイアログの Color Cutoff をオンにして、800 以下をカットオフします。Contour & 

Multi-Coloring Details ダイアログを閉じます。 

これで、アニメーションを再生するときに、クリティカルな破損しきい値を超える 2 つのステップが存在します。

Plot サイドバーのチェックボックスをオンにして translucencｙ (半透明) を有効にすると、該当部分をさらにはっ

きりと表示することができます。 
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Step 7  3D マルチフレーム 

3D Multi Frames オプションを選択すると、さらに優れた可視化を行うことができます。Frame>3D Multi 

Frames を選択し、左上のオプション を選択すると 3 つの追加フレームが表示されます。これらのフレームは、コ

ネクティングロッドの追加の正投影で、自動的に作成されます。Play ボタンを再度クリックすると、フレームがそ

れぞれリンクされ、すべてのフレームがともにアニメーション化されます。 
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このチュートリアルのセグメントにおける最終結果のスナップショットを含む Tecplot 360 EX layout (.lay) ファ

イルは Getting Started バンドルの ConnectingRod/FinalLayouts/connecting_rod_1.lay に格納されていま

す。 

5 - 2   If ステートメントによるデータ変更 

このセクションでは、if ステートメントを使用して、応力しきい値が交差する場所を計算します。 

前のセクションから続けている場合は、必ず画面を 1 つのフレームに戻してください。Frame>3D Multi Frame を

選択し、赤い x アイコン (右下隅) を選択すると素早く行えます。これで、画面には一つのフレームのみが表示され

ます。 

前のセクションを終了していない場合は、Von Mises stress (ミーゼス応力) を計算し ( Step 3 ミーゼス応力を計

算する を参照)、 Value Blanking for Von Mises Stress を equal to zero に設定します ( Step 5 コネクティング

ロッドを分離する を参照)。  

Step 1  数式の指定 

メニューバーから Data>Alter>Specify Equations を選択し、Specify Equations ダイアログを起動します。テキ

ストフィールドに次の数式を入力します: {maxStress} = IF ({Von Mises Stress}>800, 0, 1) 
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下部にある Compute ボタン を押すと、 Information ポップアップが表示され、“Data alteration successful” と

表示されます。OK をクリックし、Specify Equations ダイアログを閉じます。 

Step 2  等高線を表示する 

Plot サイドバーで Contour の隣にある ボタンを選択し、再度 Contour & Multi-Coloring Details ダイアログ

を開きます。等高線の変数を、作成したばかりの maxStress に変更します。Contour の設定が以下の画像のように

なっているかを確認します。前のセクションで有効になっている場合は、忘れずに color cutoff を削除してくださ

い。 
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自分のデータが上記の図のように十分な等高線レベルを含んでいない場合は、Set Levels ボタンを選択します。する

と、 Enter Contour Levels ダイアログが表示されます。Level Creation モードを “Exact Levels” に設定し、 

minimum を 0.05, maximum を 0.95, delta を 0.05 に設定します。詳細については Step 4 ミーゼス応力による

等高線 を参照してください。 

これで if ステートメントで指定した 800 のしきい値の領域が明らかにされました。ただし期待どおり、Tecplot 

360 EX は 0 と 1 をプロットしているわけではありません。デフォルトでは Tecplot 360 EX は、セル値間の値を

補完します。Contour & Multi-Coloring Details ダイアログを閉じます。 
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Step 3  プライマリセル値によるフラッド 

等高線表示による補間を最小化するには、Plot サイドバーにある Zone Style ダイアログ を開きます。Contour タ

ブを選択し、Contour Type を “Primary value flood” に設定します。  

 

Zone Style ダイアログ を閉じ、結果のプロットに黄色と青のみが含まれていることを確認します。青のセルは、ミ

ーゼス応力のしきい値が合致したか、超えている場合に発生します。  
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5 - 3   経時的 最大応力のプロット 

このセクションでは、マクロを使用して経時的に最大応力をプロットし、フレーム間の解析時間をリンクします。  

Step 1  マクロのロード 

前のセクションから続けている場合は Contour variable を Von Mises Stress に戻します (詳細については ミーゼ

ス応力による等高線 を参照)。そして、Scripting>Play Macro/Script... をクリックすると “Open Macro” ダイアロ

グが表示されます。再度、connecting rod フォルダに移動し、 PlotMaxContourOverTime.mcr を選択します。 

Open を選択すると、マクロが自動的に実行され、各時間ステップにおけるミーゼス応力の最大値の XY プロットが

作成されます。Play ボタンを押すと、マーカーのラインが XY プロットに続き、解析時間を追跡します。 
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このチュートリアルのセグメントにおける最終結果のスナップショットを含む Tecplot 360 EX layout (.lay) ファ

イルは Getting Started バンドルの ConnectingRod/FinalLayouts/connecting_rod_2.lay に格納されていま

す。 

Step 2  マクロの概要: ゾーンの作成 

マクロファイルのこの最初の部分が輪郭変数を取得し、その名前を検索します。それから、マクロは過渡データ内で

時間ステップ数を検索し、ゾーンを作成します。 

# Get the variable name of the contour variable (limited to Contour  

Group #1) 

$!EXTENDEDCOMMAND  

  COMMANDPROCESSORID='extendmcr' 

  COMMAND='QUERY.VARNUMBYASSIGNMENT "C" ContourVarNum' 

$!EXTENDEDCOMMAND  

  COMMANDPROCESSORID='extendmcr' 

  COMMAND='QUERY.VARNAMEBYNUM |ContourVarNum| ContourVarName' 

# 

# Create a new zone that represents the MAXC value 

# over time.  MAXC returns the maximum value of the 

# variable which is assigned to Contour Group #1. ??????????? 

# the scripting guide for more detail on MAXC. 

# 

$!EXTENDEDCOMMAND  

  COMMANDPROCESSORID='Extend Time MCR' 
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  COMMAND='QUERY.NUMTIMESTEPS NUMTIMESTEPS' 

$!CREATERECTANGULARZONE  

  IMAX = |NUMTIMESTEPS| 

  JMAX = 1 

  KMAX = 1 

  X1 = 0 

  Y1 = 0 

  Z1 = 0 

  X2 = 1 

  Y2 = 0 

  Z2 = 0 

$!VARSET |TimeZone| = |NUMZONES| 

$!RENAMEDATASETZONE 

  ZONE = |TimeZone| 

  Name = "Max |ContourVarName| over Time" 

垂直バーが使用される場所は、マクロ変数の使用を示します。これらは、組み込み変数 (Scripting 

Guide 参照) $!VARSETCOMMAND または 特定の $!EXTENDEDCOMMAND の呼び出しによって

定義することができます。 

まずは、最初の 2 つの拡張コマンドを組み合わせて Contour Group 1 で定義された変数で変数番号を抽出し、それ

を使用して名前を抽出し、変数名を取得します。その後、スクリプトは、これを新規ゾーンの一部として使用しま

す。  

スクリプトは ‘QUERY.NUMTIMESTEPS’を使用したタイムステップの数を決定します。これは時間ステップの数で

次元化された I-オーダーゾーン (J = K = 1 における矩形ゾーン) の作成に使用されます。  

$!VARSET コマンドを使用して、ゾーンの総数に基づいて新しい内部マクロ変数が作成されます。新規ゾーンは最

後に作成されたゾーンのため、このゾーンのインデックスがゾーンの最大数に相当します。そして、前に見つかっ

た Contour 変数を使用してゾーンの名前が変更されます。  

Step 3  マクロの概要: 変数変更 

次のステップでは step 2 で作成したゾーンにミーゼス応力の最大値を設定します。このプロセスで重要なのは、組

み込み変数 |MAXC| の使用で、この変数により、現在アクティブなゾーンの最大値が返されます。 

$!LOOP |NUMTIMESTEPS| 

 $!EXTENDEDCOMMAND  
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    COMMANDPROCESSORID='Extend Time MCR'  

    COMMAND='SET.CURTIMESTEP |LOOP|' 

 $!EXTENDEDCOMMAND  

    COMMANDPROCESSORID='Extend Time MCR'  

    COMMAND='QUERY.TIMEATSTEP |LOOP| SolutionTime' 

  # Instead of creating new variables, we just reuse variables 

  # #1 and #2. This keeps the dataset a little cleaner, but if we 

  # really wanted to create new variables we could do so using 

  # the $!ALTERDATA command 

  # Variable #1 represents Solution Time 

  $!SETFIELDVALUE 

    ZONE = |TimeZone| 

    VAR = 1 

    INDEX = |LOOP| 

    FIELDVALUE = |SolutionTime| 

  # Variable #2 represent the Max Contour Value 

  $!SETFIELDVALUE 

    ZONE = |TimeZone| 

    VAR = 2 

    INDEX = |LOOP| 

    FIELDVALUE = |MAXC| 

$!ENDLOOP 

 |LOOP| がループ内にある場合は、現在のループカウントの値を返す組み込み変数です。  

‘SET.CURTIMESTEP’ が確実に現在の時間だけをアクティブにし、 |MAXC| の計算で使用されますが、マクロのこ

の部分は、現在の時間ステップをアクティベートするすべての時間ステップでループします。  

ループ内でも $!SETFIELDVALUE コマンドが、指定した変数とゾーンのコマンド値を設定するために使用されま

す。この場合 ‘QUERY.TIMEATSTEP’ で抽出された解析時間と、step 2 で作成されたゾーンに対する |MAXC| 値を

設定しています。  

新規 XY プロットの作成に備えて、プロットをクリーンアップするために、マクロはいくつかの単純な動作を実行し

ます。 
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# We deactivate the zone we just created because we don't want it 

# to display in the current plot.  We'll show it in a new frame instead. 

$!ACTIVEFIELDZONES -= [|TimeZone|] 

# Turn on Time linking because we'll be turning on the 

# Solution Time axis marker on the following XY frame and 

# we want that marker to update as we animate over time. 

$!LINKING BETWEENFRAMES {LINKSOLUTIONTIME = YES} 

# Make sure the active frame is at the top of the frame stack.  This 

# ensures that the new frame we create below will inherit this dataset $!FRAMECONTROL 

MOVETOTOPACTIVE 

まず、新しく作成されたゾーンのフィールド マップは、表示方法に影響を与える可能性があるため、元のプロット

の表示から削除されます。Frame linking が有効になり、フレームが全面に移動されます。  

Step 4  マクロの概要: XY プロットを作成する 

次のステップでは、3D プロットの現在の時間ステップを示すマーカーを使用して新規作成されたゾーンの新規 XY 

プロットを作成します。 

# Now plot the new zone in an XY plot 

$!CREATENEWFRAME  

  XYPOS 

    { 

X = 1.3947 

Y = 4.6447 

    } 

  WIDTH = 8.1217 

  HEIGHT = 3.2862 

$!PLOTTYPE = XYLINE 

$!DELETELINEMAPS  

$!CREATELINEMAP  

$!LINEMAP [1]  NAME = 'Max |ContourVarName| Over Time' 

$!LINEMAP [1]  ASSIGN{ZONE = |TimeZone|} 

$!ACTIVELINEMAPS += [1] 

$!VIEW FIT 

$!XYLINEAXIS XDETAIL 1 {TITLE{TITLEMODE = USETEXT}} 



 5 - 4   次のステップ 
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$!XYLINEAXIS XDETAIL 1 {TITLE{TEXT = 'Solution Time'}} 

$!XYLINEAXIS YDETAIL 1 {TITLE{TITLEMODE = USETEXT}} 

$!XYLINEAXIS YDETAIL 1 {TITLE{TEXT = 'Max |ContourVarName|'}} 

# Show the solution time axis marker in the XY frame. We turn 

# on solution time frame linking to ensure the line updates when 

# we animate in the other frame. 

$!LINKING BETWEENFRAMES {LINKSOLUTIONTIME = YES} 

$!XYLINEAXIS XDETAIL 1 {MARKERGRIDLINE{SHOW = YES}} 

新規フレームを作成するための XY 位置と寸法が提供されます。この新規フレームは自動的に新たなアクティブフレ

ームになります。このため、プロットタイプおよび $!CREATENEWFRAME コマンドの後で呼び出されたほかのコ

マンドを変更しても、最新のフレームのみに反映され、元のフレームには反映されません。  

デフォルトでは、プロットタイプが XY Line に変更されると、線図が自動的に作成されます。カスタムの線図を作

成するために $!DELETELINEMAPS コマンドが呼び出される必要があります。この場合、１つの線図のみが必要で

す。新規作成された線図に名前とゾーンが割り当てられアクティベートされます。デフォルトでは、線図では、各ゾ

ーンの最初の２つの変数が使用されます。そのため、step 3 で、最初の 2 つの変数のみを編集しました。 

プレゼンテーション用にプロットをクリーンアップするため、XYLINEAXIS コマンドを使用してタイトルが設定さ

れます。最後の 2 行により、新規フレームが前の解析時間と確実にリンクされ、両方のフレーム間の現在の解析時

間を追跡するマーカーラインが作成されます。 

5 - 4   次のステップ 

これで Tecplot 360 EX の有限要素解析チュートリアルは終章です。User’s Manual や Help (Help>Tecplot 360 

EX Help) を参照して、このチュートリアルで用いた一般的または特定の機能をさらに深く掘り下げたいと思うかも

しれません。 

弊社では定期的に製品の機能を紹介するビデオを作成しており、新規ユーザー向けの導入的トピックだけではなく、

上級ユーザー向けに最新のリリースで追加された新機能を中心としたトピックも紹介しています。Web サイト 

https://www.tecplot.com/category/tecplot-360-videos/?product=360 または、YouTube チャンネル https:// 

www.youtube.com/user/tecplot360/ で参照することができます。 

  

https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.youtube.com/user/tecplot360/
https://www.youtube.com/user/tecplot360/
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6 内燃機関 (内燃エンジン) 

このチュートリアルでは、単気筒エンジンの CONVERGE の過渡データセットを使用します。データは Getting 

Started Bundle からダウンロードすることができます。 

内燃機関チュートリアルは 3 つのセクションで構成されています。最初のセクションでは、Tecplot によるデータの

ロードおよび、プロットのスタイル設定に関する一般的な知識について説明します。２番目のセクションでは、さら

に客観的視点で、各セグメントで個別の内容を提供します。各セグメントの終わりにはレイアウトファイルが用意さ

れており作業を確認することができます。各セグメントにおける総合的な難易度、説明、機能を以下に示します。  

番号とレベル タイトルと説明 使用される機能 

1 - 初級 
CONVERGE single cylinder デ ー タ セ ッ ト を 

Tecplot 360 EX にロードする。 

• Data Loading 

• Zone Style 

2 - 中級 

プロットのスタイルおよび、派生オブジェクトを

追加して、アニメーションプットを作成し、ムー

ビーファイルにエクスポートする。 

• Slices 

• Zone Style 

• Iso-surfaces 

• Scatter 

3 - 初級 
CONVERGE 特有のデータファイルをロードし、

XY プロットを設定する。 

• Data Loading 

• XY Plotting 

  

https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
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6 - 1   データのロードおよび操作 

Step 1  Tecplot 360 EX を起動してデータセットをロードする 

Windows の場合はスタートメニューをクリック、Linux の場合はターミナルウィンドウに tec360 と入力、Mac 

OSX の場合はアプリケーションフォルダ内で目的のアプリケーションアイコンをダブルクリックして Tecplot 360 

EX を起動します。Tecplot 360 EX の初期画面が以下のように表示されます(このドキュメントでは Windows バー

ジョンの TecPlot 360 EX の例を示しますが他のプラットフォームでもほぼ同様に表示されます)。   

 

初期画面は Tecplot 360EX を起動するたびに表示され、最近使用したレイアウトに簡単にアクセスすることができ

ます。また、ドキュメンテーションおよび、有益な他の資料に素早くアクセスできるリンクも表示されます。  



 6 - 1   データのロードおよび操作 
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データのロードを開始するには初期画面の上部から Load Data をクリックします（または、メニューバーの File ド

ロップダウンメニューから Load Data を選択するか、ツールバーの左から 2 番目にあるフォルダアイコンをクリッ

クすることもできます。初期画面が表示されないときに便利です）。  

 

Tecplot 360 EX Getting Started Bundle フォルダに移動し、Internal Combustion Engine (ICE) フォルダを指定

します。すべての .plt ファイルを選択し、Open を選択します。データファイルが開かれ、以下のように Tecplot 

360 EX のワークスペースに Combustion Engine の 3D プロットが表示されます。 

 

https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
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Step 2  流体ボリュームゾーンの境界ボックスを無効にする  

初めてサンプルファイルをロードしたとき、オレンジ色の破線が表示されているのに気付くかもしれません。これ

は、グリッドボリュームゾーンの境界ボックスで、エンジン内の空気を表します。このゾーンにはスタイル（外観）

が存在しないため通常は表示されません。Tecplot 360 EX では、この存在と大きさがわかるようにオレンジ色の破

線が追加されます。このラインは非表示にすることができます。Options メニューから “Show Bounding Boxes 

for Enabled Volume Zones with No Style” を選択します。オレンジ色のラインが非表示になります。 

Step 3  排気口を非表示にする 

対象データのほとんどがシリンダー内にあるため、表示されているゾーンを右クリックして "Hide"を選択し、排気

ゾーンを非表示にします。  

 

できるだけ多くの排気口ゾーンを非表示にしてください。非表示にした後は、以下のように表示されます。アクティ

ブなゾーンがまだいくつかあっても問題ありません。 
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6 - 2   データセットを詳しく探る  

このセグメントは、中断しているところから開始します。最初のセグメント以降、Tecplot 360 EX を閉じてしまっ

た場合は ICE/finallayouts/ICE_GS1.lay に用意されているレイアウトファイルをロードすることができます。 

Step 1  スライスを追加する  

スライスを追加するには Plot サイドバーにある Slices チェックボックスをオ

ンにします。ボリュームゾーン全体にスライスが表示されますが、サーフェス

によって隠れていることがあります。エンジン中央を含めてスライスが見える

ようにするには、 Plot サイドバーの Translucency もオンにする必要があり

ます。 

slice interactor ツールを選択して、そこからスライスを移動し、インタラク

ティブに配置することができます。 interactor  ツールは、スライスをクリッ

クまたはドラッグして目的の場所に移動できます。これは、Slices チェックボックスの隣にあるボタンを選択しても

行うことができます。ここでは、スライスをデフォルトの場所に残します。Sice details ダイアログで現在の Slice 

の位置と方向が表示されます。  
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Slice Details ダイアログに正確なスライスの位置が表示されます。 

 

Step 2  スライススタイルの設定  

等高線を設定する  

Slice Details ダイアログが開いたままであれば、Contour タブに移動します。スライスが "mass" で等高線表示さ

れているのがわかります。現在、変数が Contour Group 1 に割り当てられているためです。Slice Group 1 内の変

数を変更するには、 Plot サイドバーの "Contour" の隣にある  ボタンをクリックします。これにより、

Contour Details ダイアログが開かれます。このダイアログは、Slice Details ダイアログの Flood By フィールドの

隣にあるにあるギアアイコンを選択しても開くことができます。 
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Contour Group 1 の変数を変更するには、Contour Details ダイアログの上部にある "1" ボタンを選択し、現

在 mass を表示しているドロップダウンリストを選択します。ここでは temp を選択します。Contour Details ダ

イアログを閉じます。  

 

Slice Details ダイアログに戻ると、Contour タブの変数も temp に変わります。contour グループの変更に成功！ 
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メッシュをオンにする  

スライスのメッシュも確認したいのでこれもオンにします。画面上のスライスを右クリックしてコンテキスト メニ

ューを開き、メッシュ オプションを選択します。下記に表示されています。  

 

スライスメッシュは、Slice Details ダイアログの Other タブでオンにすることもできます。ツールバーの虫眼鏡を

選択すると、拡大して見ることができます。 

Plot サイドバーで、 Forward、Back および Play ボタンを使用して、経時的にプロットが変化する様子を確認して

ください。  

Step 3  噴霧パーセルを表示する  

スライスはシリンダー内の経時的な温度変化の良い目安になります。ただし、使用できるツールはスライスだけでは

ありません。このデータセットには、噴霧情報も含まれており、エンジンの可視化に役立つ場合があります。理解す

るために、Plot サイドバーの Solution Time が最初の時間ステップに設定されていることを確認します。  

Plot サイドバーから、Zone Style ダイアログを開き、Zone リストの下部までスクロールします。そこに "Spray"  

と呼ばれるゾーンがあります。このゾーンのスタイルを独自の仕様にしたいと思います。そのために、Plot サイド

バーから Scatter チェックボックスを選択します。 

プロットがすべてのゾーンで Scatter シンボルを伴って更新されます。しかし、これは目的とは異なります。

"Spray"  ゾーンに表示したいのは、scatter シンボルのみです。Zone Style ダイアログで、Scatter タブを選択

し、 "Spray" ゾーン以外のすべてのゾーンをハイライトします。 "Show Scatter" 列を右クリックして No. を選択

します。  
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Step 4  噴霧パーセルのサイズを変更する  

現在、"Spray"  ゾーンには scatter プロットのみが表示されていますが、同じサイズの正方形として表示されてい

ます。Scatter タブを選択し、symbol shape を右クリックして、 Sphere に変更します。  

シンボルのサイズを変更したいので Symbol Size の列を右クリックして "Select Variable"  オプションを選択しま

す。  

 

これにより、 Scatter Size/Font メニューが開かれます。 
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半径サイズの Scatter シンボルを適用するには、scatter symbol variable ドロップダウンメニューから、変数 

Dp_radius を選択します。しかし、プロットはまだ更新されていません。最後にもう一度、symbol size ドロップ

ダウンメニューを右クリックし DP_radius 変数を選択します。Zone Style は以下のように表示され、プロットに

は半径によってサイズが決められた散布球が表示されます。 

 

Step 5  噴霧パーセルのカラーを変更する  

噴霧のサイズは異なっていますが、それでも十分な情報を得ることはできません。温度による scatter シンボルの

等高線表示が役立ちます。再度、Zone Style ダイアログを開き、Scatter タブを指定します。"Spray" ゾーンまで

スクロールダウンしたら Outline Color まで右にスクロールします。Outline Color を右クリックすると、Color 

Chooser メニューが表示されます。  

 

Multi 2 を選択します。これは Contour & Multi-Coloring group 2 に該当します。group 2 の変数を変更するため、

Contour トグルの隣のサイドバーで  ボタンを指定して Contour Details ダイアログに戻ります。パーセルには

DP_temp で等高線表示されるカラーを指定する必要があります。これで、時系列でパーセルの温度と大きさの変

化を見ることができるようになりました。 
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Parcel カラーを変更したあとは、画面に２つ等高線の凡例が表示されます。これは、スライスが temp で等高線表

示されている間に、パーセルが DP_temp で色付けされたためです。両方の等高線が温度に準拠しているため、両

方の等高線グループの等高線レベルを更新することができます。  

最初に、凡例を右クリックして Hide を選択し、等高線グループ 2 の凡例を削除します。次に、 Levels and Color 

タブを指定し、Set Levels ボタンを選択します。入力レベルの情報が、以下のように表示されます。 
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group 1 で繰り返します。これにより、temp および DP_temp が同じスケールに更新されます。 

注意: パーセル噴霧の Sphere がグラフィックを多用するシステムもあります。その場合は、Point 形状または円形

を使用してください。ポイントはサイズ変更できませんが、Sphere とよく似たカラーを使用することができます。 

補足 – 構成ファイルでデフォルトの散布図スタイルを設定する  

一般的なワークフローで、単一ゾーンに散布図が含まれる場合、デフォルトのスタイルを変更すると、クリック数を

大幅に減らすことができます。 

これらのコマンドは、散布図のデフォルト値を "off"にして、形状を "Point"に変更します。これは、一つのゾーン

のポイントのみをオンにしたい例の場合などで特に便利です。構成ファイルでは、カラー等高線は設定できないこと

に注意してください。  

インストールフォルダにある tecplot.cfg ファイルに、散布図のデフォルトの形状、および、簡易性を設定すること

ができます。任意のテキストエディターにファイルを開き、以下の行を設定ファイルに追加します。   

$!FieldMap Scatter{ 

  Show = No 

  SymbolShape{GeomShape = Point} 

} 

Step 6  等値面（Iso-Surface）を作成する  

次のステップでは、等値面 (Iso-surface) を使用して、エンジンの着火段階における火炎前面を可視化します。サイ

ドバーの Slices チェックボックスを外して step 1 および sｔep 2 で作成したスライスをオフにしますが、任意で 

Point scatter shape を使用して Parcels はオンにしたままにします。データは以下のように表示されます。  
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次に、Plot サイドバーにある Iso-Surfaces チェックボックスをオンにします。"Iso- Surfaces" の隣のチェックボ

ックスを選択したら、   ボタンを選択します (Slice details ダイアログの開き方と同様)。これにより、

Isosurfaces Details ダイアログが開かれます。 

 

火炎前面を可視化するため、Contour Group 1 で設定された、変数 temp を使用します。Iso-surface ダイアログ

で Contour タブを選択し、Iso-surface が temp で等高線表示されているかも検証します。 
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Details ページに戻り、Iso-surface の値を 2000 に設定します。これにより、火炎前面が表されます。 

 

Plot サイドバーで play ボタンを押して、火炎前面の伝播をアニメーション表示します。 

Step 7  3D マルチフレームを使用する  

可視化したデータが一体となりはじめています。しかし、複数の角度からデータを表示すると便利な場合がありま

す。これにより、すべての側面からのデータをよく理解することができます。これは、Frame > 3D Multi Frames 

を選択すると、簡単に行うことができます。この例では左上のオプションを使用します。 
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このオプションを使用すると、データセットの直交表示が可能で、全時間を通してデータをよく理解することができ

ます。  

 

Step 8  ムービーファイルにエクスポート  

プロットを希望どおりに設定したので、最終生成物をムービーファイルにエクスポートしましょう。Solution Time 

の隣の  ボタンを選択して Time Animation Details ダイアログを開きます。 

 

このダイアログには、Plot サイドバーよりもさらに高度なアニメーションのオプションが表示されます。  



6 内燃機関 (内燃エンジン) 

142 

 

Time Animation ダイアログで VCR ボタンの隣の "Export to File" ボタンを選択します。すると、Animation 

Export ダイアログが開かれます。アニメーションエクスポートのデフォルトは MPEG-4 です。ワークスペースには 

3D マルチフレームがあるため、領域が "All Frames"であるか確認します。  

 

現在の表示よりも大きいイメージ幅でのエクスポートを選択することもできます。この機能は、高解像度の画面で

表示する場合で特に便利です。この例では、最終生成物は 4K 解像度画面で表示したいので、 width は 4096 を入

力します。OK を選択して、最終ファイルを保存します。 

6 - 3   セル平均出力ファイルをロードする (CONVERGE) 

このセクションでは、CONVERGE からエクスポートした時刻歴データを使用します。CONVERGE ユーザー向けに

多少特化していますが、一般的な時刻歴の機能を示します。前のセグメントから継続している場合は File > New 

Layout を選択して、前のプロットを削除してください。 



 6 - 3   セル平均出力ファイルをロードする (CONVERGE) 
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Step 1  データをロードする  

Getting Started Guide Bundle の ICE_Examples ディレクトリから area_avg_flow.out をロードします。File> 

Load Data を選択します。ダイアログが表示されたら、CONVERGE Output Loader を選択します。 

 

OK を選択するとプロットが XY ラインタイプでロードされます。 

Step 2  複数の Y 軸を追加  

デフォルトのプロットは XY Line モードで、 XY Line マップが組み込まれています。使用可能なマッピングを確認

するには Plot サイドバーで Mapping Style ボタンを選択します。Crank Angle (クランク角) に対してあらかじめ

用意された多くの変数を伴ってファイルがロードされたことが分かります。この例では、Crank Angle で 

Avg_Temp および Mass_Flow_Rate を表示するようにプロットを変更します。Cycle Number に対する Crank 

のデフォルトマップをオフにします。Map number 2 および 5 をオンにします。 
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プロットがどのように自動的に両方のラインを一つの Y 軸に統合するかに注目してください。Mass_Flow_Rate 

と Avg_Temp の min/max 値は非常に異なるため、2 番目の Y 軸にマッピングの一つを配置すると便利です。 

 

再度、Plot サイドバーで Mapping Style ボタンを選択します。"Which Y-Axis" 列まで右にスクロールして、 

Avg_Temp 行を右クリックします。そして、Y-Axis に Y2 を選択します。プロットが自動的に更新されます。 

 

最後に、Mapping Style ダイアログを閉じて、最終的なプロットを確認します。プロットが自動的に新しい軸の境

界に更新されない場合は、 Ctrl+F (または、View > Fit to Full Size ) を選択します。  
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ラインを太くするには、ラインを右クリックしてコンテキストメニューを表示し、目的の太さにラインを更新しま

す。白黒印刷する場合は、ラインの 1 つを破線に変更することを検討してください。 

Step 3  グリッド線の追加  

Plot > Axis を選択して、Axis Details メニューを開きます (または、軸をダブルクリックします)。Axis Details メ

ニューで、プロットの軸を更新するためのさまざまなタブを確認することができます。X1, Y1, X2 ... ボタンに注意

してください。これらは、動作する軸を制御します。今は、X1 Grid Line を更新します。X1 軸のグリッド線を更新

するには、Grid タブを選択します。Y1 ボタンも選択して、Y1 の Grid オプションを更新します。この例の場合、

Y1 は Mass_Flow_Rate です。   
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Gridlines および Minor Grid Lines の下の Show チェックボックスを選択します。Major Tick ラベルには Solid の

グッド線、および Minor Tick ラベルには Dotted グリッド線があることに注意してください。  

次に、Y2 ボタンを選択して Avg_Temp の Grid Line を編集します。前のように Gridline を表示しますが、今回は 

Minor Gridlines をオフにします。また、主要なグリッド線の間で、区別がないことにも注目してください。こうし

た理由から、Gridline のカラーを “Blue” に更新することにします。  

 

Step 4  軸ラベルの更新  

次は、軸ラベルの間隔がさらに適切になるように更新します。Avg_Temp では、軸ラベルは各ステップ間で 100

ポイントの間隔なので、Y2 を更新する必要はありません。しかし、さらに間隔を整えるために Y1 を更新します。

Axis Details ダイアログで、Labels タブを選択します。 

下部の Auto Spacing オプションをオフにすると Label Spacing の制御が可能になります。Spacing フィールド

で、数字を 0.025 に更新します。Axis Details ダイアログを閉じます。  
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最終的にプロットは以下のようになります。  
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6 - 4   次のステップ 

これで Tecplot 360 EX の内燃機関 (内燃エンジン) チュートリアルは終章です。User’s Manual や Help 

(Help>Tecplot 360 EX Help) を参照して、このチュートリアルで用いた一般的または特定の機能をさらに深く掘り

下げたいと思うかもしれません。 

弊社では定期的に製品の機能を紹介するビデオを作成しており、新規ユーザー向けの導入的トピックだけではなく、

上級ユーザー向けに最新のリリースで追加された新機能を中心としたトピックも紹介しています。Web サイト 

https://www.tecplot.com/category/tecplot-360-videos/?product=360 または、YouTube チャンネル https:// 

www.youtube.com/user/tecplot360/ で参照することができます。 

https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.tecplot.com/category/tecplot-360-videos/?product=360
https://www.youtube.com/user/tecplot360/
https://www.youtube.com/user/tecplot360/


 

 

 149 

 
Part 3 海洋モデル



 

 

150 

7 海洋モデル 

このチュートリアルでは、ボストン港における過渡 FVCOM NetCDF データセットを使用します。データは 

Getting Started Bundle からダウンロードすることができます。 

このデータセットは UMASS の Chen 研究室より提供されました。元のデータは ここ にあります。 

Tecplot にロードするには FVCOM NetCDF データファイルに nv (element to node connectivity), siglev (sigma 

level), h (depth), zeta (surface elevation), (lon,lat) または (x, y) 座標が必要です。Tecplot 360 は、上記の変

数なしでは FVCOM NetCDF データを扱うことができません。各セグメントにおける総合的な難易度、説明、機能

を以下に示します。 

番号とレベル タイトルと説明 使用される機能 

1 - 初級 
Boston サンプルデータセットをロードしてデー

タを確認する。 

• Data Loading 

• Data Set Information 

2 - 中級 

プロットのスタイルと値のブランキングを追加し

てアニメーションプロットを作成し、ムービーフ

ァイルにエクスポートする。 

• Contours 

• Zone Style 

• Axis Scaling 

• Value Blanking 

3 - 中級 
サーフェスのベクトル場を可視化し、ジオリファ

レンス画像を挿入する。 

• Vectors 

• Georeferenced Image 

• Stratification 

4 - 上級 Tecplot ウェブサイトに用意されている高度なト

ピックにリンクします。 

• PyTecplot 

• Averages 

• Shapefiles 

 

https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
https://tecplot.azureedge.net/data/360GettingStarted.zip
http://www.smast.umassd.edu:8080/thredds/catalog/models/fvcom/NECOFS/Forecasts/catalog.html?dataset=models/NECOFS/Forecasts/NECOFS_FVCOM_OCEAN_BOSTON_FORECAST.nc
http://www.smast.umassd.edu:8080/thredds/catalog/models/fvcom/NECOFS/Forecasts/catalog.html?dataset=models/NECOFS/Forecasts/NECOFS_FVCOM_OCEAN_BOSTON_FORECAST.nc
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7 - 1   データのロードおよび操作 

Step 1  Tecplot 360 EX を起動してデータセットをロードする 

Windows の場合はスタートメニューをクリック、Linux の場合はターミナルウィンドウに tec360 と入力、Mac 

OSX の場合はアプリケーションフォルダ内で目的のアプリケーションアイコンをダブルクリックして Tecplot 360 

EX を起動します。Tecplot 360 EX の初期画面が以下のように表示されます(このドキュメントでは Windows バー

ジョンの TecPlot 360 EX の例を示しますが他のプラットフォームでもほぼ同様に表示されます)。 

 

初期画面は Tecplot 360EX を起動するたびに表示され、最近使用したレイアウトに簡単にアクセスすることができ

ます。また、ドキュメンテーションおよび、有益な他の資料に素早くアクセスできるリンクも表示されます。 

データのロードを開始するには初期画面の上部から Load Data をクリックします（または、メニューバーの File ド

ロップダウンメニューから Load Data を選択するか、ツールバーの左から 2 番目にあるフォルダアイコンをクリッ

クすることもできます。初期画面が表示されないときに便利です）。 
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Tecplot 360 EX Getting Started Bundle フォルダに移動し、Ocean フォルダを指定します。.nc ファイルをハイ

ライトし、Open を選択して、このファイルを Tecplot 360 EX で開きます（このファイルが表示されない場合はダ

イアログの下部にあるメニューから All Files を選択してください）。データファイルが開かれ、以下のように、ボス

トン港の 3D プロットが Tecplot 360 EX のワークスペースにロードされます。オレンジ色のボックスはボリューム

データの境界を示しています。  Chapter 3 ボリュームサーフェスについて を参照してください。 

 

https://tecplot.azureedge.net/data/360GettingStarted.zip
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Step 2  データを検査する 

オレンジ色の境界ボックスは、スタイルなしでロードされたボリュームデータセットを表しています。サーフェスプ

ロットの詳細については Chapter 3 ボリュームサーフェスについて を参照してください。ロードされたデータを確

認するには Data Set Info ダイアログを開きます。画面の上部から Data-> Data Set Info を選択します。これに

より、ロードしたゾーンと変数のリストを含むダイアログが表示されます。  

 

Zones フィールドで、NetCDF 海洋モデルが 24 ゾーンをロードしたことが確認できます。この場合、それぞれのゾ

ーンは、データの時間ステップを表しているため、合計で 24 時間ステップが存在します。他の列でデータセットか

らロードされた変数を確認することができます。Data Set Information ダイアログを閉じます。 

7 - 2   最初のプロットを作成する 

Step 1  Contour を有効にしてドメインを確認する 

最初のデータを表示するために、Contour レイヤーをオンにします。Plot サイドバーで、Contour の隣にあるチェ

ックボックスを選択します。 
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Surfaces to Plot に関する確認のポップアップが表示されます。ここでは "Yes"を選択します。選択したデフォルト

の等高線変数が選択されて、等高線プロットが表示されます。この場合は "lon"です。その理由は "lon" がデータセ

ット内で最初の 非-XYZ 変数だからです。 

 

Step 2  XYZ を Lon, Lat に割り当てる 

このプロットでは、X 座標および Y 座標を、Lon および Lat に変更します。すると、ジオリファレンス画像などを

簡単にプロットに配置できるようになります ( “ジオリファレンス画像の挿入” を参照)。これを行うには、Plot-

>Assign XYZ を選択し、X 変数を "lon" に、Y 変数を "lat"に変更します。 
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プロットが自動的に更新されます。 

Step 3  Z-スケーリングを調整する 

"Aspect ratio exceeds ratio limit. .（縦横比が比率限度を超えています。比率が調整されました）"というポップア

ップが表示される場合があります。比率が調整されました。"これは、視覚的に興味深い軸の比率を保持し、いずれ

かの方向が小さくなりすぎないようにするためです。しかし、現在のプロットは Z 方向が高すぎるため、この比率

を調整します。Plot-> Axis を選択して、Axis Details ダイアログを開きます。 

ダイアログの下部は、Dependency フィールドです。これらのオプションによって、ユーザーの情報を元にした 

XYZ の依存関係を決定することができます。Z-軸は小さくする必要があるため、プロットを "XY Dependent"に設

定します。"XY Dependent" ボタンを選択し、Z 軸の Size factor を "0.000667"などに調整します。 

 

まだ Z-軸が大きすぎますが、全体的に分かりやすくなったことに注目してください。 

Step 4  表示と光源の変更 

上から下に見るように地図を変更する場合は、ローラーボール回転 (右図) を選択し、視点が上から下になるように

画面をドラッグします。 

 

別の方法としては Plot サイドバーで "Snap to Orientation view" を選択して、 XY perspective を選択します。 
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この角度からは、ライティング効果により等高線カラーが薄くなります。今は、Plot サイドバーで "Lighting"  チェ

ックボックスのチェックを外して、光源をオフにします。 

 

これで、プロットにライティング効果がなくなり、等高線データがより明確に表示されます。 

 

Step 5  等高線変数とカラーマップの変更 

これまで等高線変数はデフォルトの "lon" のままです。さらに多くのデータを "Salinity"などの関係変数に更新しま

す。そのために、Plot サイドバーで Contour の隣にある  ボタンを選択します。Contour & Multi-Coloring 

Details メニューが表示されます。 

ダイアログ上部のドロップダウンリストが "lon"に設定されていることに注意してください。ドロップダウンリスト

を選択すると、データセット内のすべての変数が表示されます。ここで、新しい等高線変数として "salinity" を選択

します。プロットが自動的に更新されます。 
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また、cmocean カラーマップに基づいて、新しいカラーマップも選択します。ここでは、salinity プロット向けに

デザインされた "cmocean - haline"カラーマップを選択します。カラーマップを変更するには、Contour & 

MultiColoring Details ダイアログから、colormap ドロップダウンリストを選択し "cmocean - haline」 オプショ

ンを選択します。 
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Step 6  Value Blanking を使用して陸地を非表示にする 

プロットを "salinity" に更新したら、プロット内のボストン港の海岸線に注目してください。また一方、等高線が海

岸線を超えて伸びています。このデータセットには "wet_node"と呼ばれる変数があり、湿っているもの (variable 

= 1 で示される) と、乾燥しているもの (variable = 0 で示される) を特定します。  

プロット上で "wet_nodes" が 0 と等しい場所の dry ノードを非表示にします。Plot->Blanking->Value Blanking 

を選択し、Value Blanking ダイアログを表示します。 

 



 7 - 2   最初のプロットを作成する 

 

 159 

次に、"Include value blanking" チェックボックスをオンにします。これにより、何かを空白にしたいことをプロ

ットに伝えます。フィールドが "wet_nodes",  "is equal to" ,  "Constant" および "0" の場合に Blank に変更しま

す。"Active" チェックボックスを選択します。これに応じて、プロットが更新されます。正確な値の空白オプショ

ンが画像の上に存在し、最終的なプロットは以下のようになります。 

 

Step 7  ムービーファイルのアニメーションとエクスポート 

プロットの見栄えが良くなりましたので、時系列でアニメーション化しましょう。プロットのアニメーションを開始

するには、Plot サイドバーで Play ボタンをクリックします。ボストン港における塩分の引き潮と流れがプロットに

表示されます。 

 

データをロードする必要があるため、初めてアニメーションを表示する際は、時間がかかることに注意してくださ

い。2 回目のアニメーション表示は、すでにデータがロードされているので速くなります。 

ここで、アニメーションをムービーファイルに保存します。Plot サイドバーで Solution time の隣にある  ボタ

ンを選択すると、Time Animation details ダイアログが表示されます。このダイアログを使用すると、プロット
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のアニメーションをさらに詳細に制御することができます。ですが、デフォルトの設定で十分なので Time 

Animation details ダイアログ内の VCR の隣にある "Export to File" ボタンを選択します。 

 

Export ダイアログが表示されます。このダイアログで、エクスポート形式、画像の幅、アンチエイリアシング、お

よびアニメーションの速度を選択することができます。ここでは、MPEG-4 形式を選択します。これにより、拡張

子 .mp4 のファイルが作成されます。これは、ほとんどの動画ビューアーで使用することができます。また、海岸

線を明確にし、より滑らかなラインを得るために antialiasing も有効にします。その他はデフォルトのままで、OK 

をクリックします。 

 

次に、ファイルを "boston_salinity.mp4"として任意の場所に保存します。Tecplot での海洋アニメーションが作成

できました。 
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7 - 3   特定の海洋プロット 

次のセクションでは、このデータセットを使用して実行できる特定のクイックプロットに焦点をあてます。最終的に

目的のプロットを素早く作成する方法を学びます。 

このセクションは、前のセクションからの続きになります。途中から参加している場合は finallayouts ディレクト

リから Ocean1.lay を開いてください。 

7 - 3. 1   サーフェスの速度を可視化する 

Step 1  ベクトルをオンにする 

サーフェスの速度を可視化するには、まず Plot サイドバーで Vector レイヤーをオンにします。等高線レイヤーを

オンしたときのように Vector の隣のチェックボックスを選択します ( Contour を有効にしてドメインを確認する  

を参照)。Select Variables メニューが表示され、U, V および W 変数を選択することができます。 

 

次のセクションでは、ドロップダウンから変数 u, v および "ww" を選択します。 

Step 2  Value Blank Siglev 

この段階では、すべてのサーフェスが海底を含むベクトルを表示しています。海面のみを表示するには、“siglev” が 

0 未満のときに、value blanking を使用して、ブランキングによって海面を分離します。2 番目のブランキング制

約を使用して、Plot -> Blanking -> Value Blanking を選択し、以下の画像と同様にオプションを更新します。

“Blank entire cells when” オプションは、必ず “all corners are blanked” に変更します。 
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Step 3  ベクトル接線の使用 

表示が 3D モデルのままで、ベクトルが画面の下に向いているため、点線のように見えるベクトルもあります。これ

を避けるため、Zone Style ダイアログで Vector Tangents をオンにします。Plot サイドバーで Zone Style ボタン

を選択すると Zone Style ダイアログが表示されます。 

 

Select the Vector タブを選択し、"Vector Tangents"の下にあるチェックを選択します。これにより、ベクトルが

確実にサーフェスの接線方向に表示されます。Zone Style ダイアログを閉じます。 
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Step 4  速度マグニチュードの計算 

Velocity Magnitude (速度マグニチュード) が現在のデータセットに存在しないため、これを計算する必要がありま

す。通常、新規方程式は Data Alter メニュー (Data -> Alter -> Specify Equations) を使用して計算することがで

きます。ただし、CFD Analyze メニューを使用して、速度の大きさを計算することもできます。このメニューを使

用すると、手動で方程式を入力する必要がなくなります。 

まず、アナライザーにデータフィールド変数を知らせて、CFD Analyze メニューを設定する必要があります。

Analyze -> Field Variables を選択し、Field Variables ダイアログを表示します。このダイアログで、解析に必要

な変数を設定することができます。この計算の場合、convective variables の設定だけで十分です。Velocity ボタ

ンがチェックされており、ベクトル変数がプロットで表示されたもの (u, v および ww) と同じであることを確認し

ます。 
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次に、Analyze -> Calculate Variables を選択します。これにより、Calculate Variables ページが表示されます。

変数の計算に Velocity Magnitude を選択し、 Calculate on Demand ボタンのチェックを外します。すると、変数

がプロットされたときではなく、直ちにポイントが計算されます。 

 

次に Calculate を計算すると、Velocity Magnitude 変数がすべてのゾーンで計算プロセスを開始します。計算が完

了すると情報が表示されます。Data Set Info ダイアログ (Data->Data Set Info) 内の変数リストの最後で Velocity 

Magnitude 変数を確認することができます。 
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Step 5  速度マグニチュードで等高線を示す 

速度の大きさで等高線表示するには、前のセクションの Step 5 等高線変数とカラーマップの変更 を参照し、等高

線変数の更新方法を確認してください。そして、速度で使用するようにデザインされている "cmocean-speed"に

カラーマップを切り替えます。この調査で関係するデータのみを含むように等高線レベルを変更します。 

これを行うには、Contour & Multi-Coloring details ダイアログで Set Levels を選択します。ダイアログが表示さ

れたら、Range Distribution のオプションを Min, Max および Delta に変更します。Minimum level は 0、

Maximum level は 0.6、Delta は 0.1 です。 
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OK をクリックし、Contour & Multi-Coloring Details ダイアログを閉じます。現在のプロットは以下のようになり

ます。 

 

Step 6  ベクトルのサイズ変更 

画面上のベクトルがプロットの高密度領域では少し大きすぎるため、長さを変更する必要があります。Plot > 

Vector > Details を選択し、Vector Details ダイアログでベクトルの長さを調整します。 
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Length を Relative (grid units/magnitude) に設定し、数値は 0.005 を指定します。これにより、プロットの濃

度領域におけるベクトルが小さくなり、扱いやすくなります。最終的にプロットは以下のように表示されます。 

 

この段階で zoom と pan ツールを使用して、データのさまざまな領域を検討することができます。 
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7 - 3. 2   ジオリファレンス画像の挿入 

Step 1  座標系の設定 

画像を挿入する前に、自分のプロットの座標系が挿入しようとしているジオリファレンス画像と同じであることを確

認します。ジオリファレンス画像がデータセットと異なる座標系で挿入された場合、正しい位置に画像が表示されま

せん。この例では、Boston データセットを lon/lat 座標に設定します。 

 

Plot > Assign XY を選択して、lon を X 変数に、lat を Y 変数に割り当てます。前のエクササイズから続けている

のであれば、このステップは既に行われています。 

Step 2  ジオリファレンス画像の挿入 

Insert > Image/Georeferenced Image を選択し、読み込まれたデータと同じフォルダから 'boston.png’ ファイ

ルを選択します。データセットとともに、ボストン港の地図が表示されます。Play ボタンをクリックして、アニメ

ーションが進むにつれてカラーマップが画像の後ろに消えることに注目してください。 

 

Step 3  画像位置の更新 

時間とともに海面高が変化するため、等高線プロットはジオリファレンスが画像の後ろに消えます。常に等高線を上

にしたいので、ジオリファレンス画像の高さを更新します。ジオリファレンス画像を右クリックし、Image Details 

を選択します。3D Image Geometry Details ダイアログが表示されます。Z position フィールドのデフォルトが０

になっていることに注意してください。このフィールドを-10 に変更して、Accept をクリックします。  
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画像が等高線フラッディングの下に移動します。もう一度、Plot サイドバーから play ボタンを選択し、海面高度が

どのように変動するかを確認しますが、以前のように画像の下部に落ちることはありません。 

 

7 - 3. 3   塩分成層について 

次は、等値面を使用してデータセットの測深法を特定し、スライスを使用してボリューム全体のレイヤーを特定しま

す。前のセグメントから続けているのであれば、ジオリファレンス画像を削除して、 siglev のブランキングをオフ

にしてください。 
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Step 1  ゾーンレイヤーをオフにする 

Plot サイドバーで、ゾーンレイヤーをオフにします。これによりプロットは、最初にデータをロードしたときとほ

ぼ同様のオレンジ色の境界ボックスを伴う、空のワークスペースに戻ります。 

Step 2  測深の表示 

Plot サイドバーにある Iso-Surfaces チェックボックスをオンにします。これにより、等高線変数の値の基づくサー

フェスが作成されます。この場合、等値面を作成して測深を表示します。そのために、iso-surface チェックボック

スの隣にある   ボタンを選択します。これにより、Iso-surfaces Details ダイアログが開かれます。 

Iso-surface の定義を C3 に設定し、-1 の値を入力します。Contour Details ダイアログで、group 3 内の 

Contour variable を siglev に変更します。上記の Contour details および Iso-surface details オプションの画像

を参照してください。また、Ctour details ダイアログを開いている間に、等高線グループを更新して、“cmocean-

deep” カラーマップを使用し、カラーマップを反転して、z によって色付けします。そして、Isosurface details ダ

イアログの Contour タブで C2 を選択します。等高線の更新の適切なオプションについては、以下の画像を参照し

てください。 
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iso-surface 定義を設定すると、データセット下部のレイヤーの等値面（iso-surface）が作成されます。プロットを

回転させると、データセットから港底の海嶺を確認することができます。 

 



7 海洋モデル 

172 

Step 3  スライスの配置 

次に、Slice ツールを使用してスライスを配置し、Y-planes を使用して 42.33 の位置に Slice Details ダイアログを

配置します。これにより、Boston データセットの中央周辺にスライスが配置されます。 

 

凡例の端を右クリックし、 “Hide” を選択して、z 凡例を削除します。以下のように、プロットを回転させてスライ

スがよく見えるようにします。 
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Step 4  塩分濃度によるスライスの等高線表示 

関心領域にスライスを配置したので、塩分濃度で等高線を作成して、塩分成層を取得したいと思います。Slice ツー

ルの隣にある   ボタンをクリックして、Slice Details ダイアログを表示します。Contour タブを選択し、 

contour group が 1 に設定されていることを確認します。 

変数がまだ塩分濃度 (salinity) でない場合は、Contour Details ダイアログで変数を更新します。 
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Other タブで slice mesh がオンになっていることも確認します。これで、最終プロットが表示されます。スライス

が、ボストン港全域の塩分成層を表示します。zoom と pan ツールを使用して、任意の向きにプロットを調整して

ください。 
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7 - 4   高度なトピック 

このセクションでは Tecplot の Python API, PyTecplot を使用した高度なトピックが含まれています。GUI と 

Python を組み合わせた GUI が提供する機能を拡張します。これにより、Tecplot 360 の機能を総合的に向上させ

ることができます。各トピックには、スクリプトへのリンク、およびリファレンスのトランスクリプトを含むビデオ

が用意されています。 

7 - 4. 1   垂直トランセクト (外部ビデオ) 

垂直横断は経時的に抽出されたカーブのスライスを提供します。垂直トランセクト (Vertical Transect) を作成する

手順を示すビデオを用意しています: https://www.tecplot.com/2018/10/17/vertical-transect/  

7 - 4. 2   時間平均 (外部ビデオ) 

Time Average スクリプトは、時間で平均化した変数によって複製ゾーンを作成します: https:// 

www.tecplot.com/2018/10/17/calculating-average-over-time/ 

7 - 4. 3   シェープファイル変換 (外部ビデオ) 

Shapefile conversion スクリプトは、シェープファイルを Tecplot .plt 形式に変換します: 

https://www.tecplot.com/2018/10/17/converting-shapefiles-plt-using-pytecplot/ 

7 - 5   次のステップ 

これで Tecplot 360 EX の過渡チュートリアルは終章です。User’s Manual や Help (Help>Tecplot 360 EX Help) 

を参照して、このチュートリアルで用いた一般的または特定の機能をさらに深く掘り下げたいと思うかもしれませ

ん。 

弊社では定期的に製品の機能を紹介するビデオを作成しており、新規ユーザー向けの導入的トピックだけではなく、

上級ユーザー向けに最新のリリースで追加された新機能を中心としたトピックも紹介しています。Web サイト 

https://www.tecplot.com/category/tecplot-360-videos/?product=360 または、YouTube チャンネル https:// 

www.youtube.com/user/tecplot360/ で参照することができます。 
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